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Introduction to ArcGIS Data Appliance
ArcGIS Data Appliance is an Esri content solution that allows you to quickly create, publish, and share maps and
related content (for example, elevation data, places locator) with colleagues securely behind your firewall. It
connects directly to your internal network and is preloaded with terabytes of detailed data from industry-leading
data providers to enhance your ArcGIS and web apps. Your maps are powered by the back-end infrastructure of the
data appliance and a server.

Note: This Data Appliance Help PDF file (arcgis_data_appliance.pdf) is for the raster basemap and reference services
on ArcGIS Data Appliance Collections 1 through 5.

ArcGIS Data Appliance consists of hardware and data. It runs with ArcGIS Enterprise, which helps make data
appliance services available to others in your organization and, optionally, anyone with an internet connection. The
data appliance hardware is a set of hard drives preloaded with data to support configuration with the data product
option you licensed from Esri.

This version of ArcGIS Data Appliance includes the following:

• Raster basemap and reference services with cartographic mapping content to help you start building critical GIS
applications right away.

• Esri's Terrain service, providing a consolidated, multiresolution dataset essential for a wide range of use cases,
from scientific study to everyday applications including hazard mitigation, conservation, infrastructure, national
security, and more.*

• Terrain 3D service, providing terrain content for visual context and analysis in ArcGIS Pro and Scene Viewer.

• Elevation analysis services that allow you to perform raster analysis on world elevation data. Use the Profile
geoprocessing service tool to create elevation profiles along any given polyline features. Use the Viewshed
geoprocessing service tool to create viewsheds for any given observation point features anywhere on the surface
of the earth. Use the Summarize Elevation geoprocessing tool to calculate summary statistics for features you
provide based on the elevation in the Terrain data.*

*Not included with World Basic (Collection 1).

ArcGIS Data Appliance includes a World Gazetteer with most product options that allows you to find on a map
more than 30 million places around the world. World Gazetteer ships separately. Learn more about World Gazetteer
on the ArcGIS Data Appliance website.

ArcGIS Data Appliance includes Esri Vector Basemaps with most product options. These maps have a smaller
footprint on disk and can be published in many styles using an Enterprise portal. Esri Vector Basemaps ships
separately. Learn more about Esri Vector Basemaps on the ArcGIS Data Appliance website.

ArcGIS Data Appliance includes OpenStreetMap (OSM) Vector Basemaps with most product options. These maps
have a smaller footprint on disk and can be published in several styles using an Enterprise portal. OSM Vector
Basemaps ships separately. Learn more about OSM Vector Basemaps on the ArcGIS Data Appliance website.

Product options
There are eight product options available with ArcGIS Data Appliance 2025. Most Data Appliance product options
are composed of multiple components, as shown in the following table:

Product option What's included

ArcGIS Data Appliance World Basic Collection 1; and OSM Vector Basemaps: Basic (WMA only)
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Product option What's included

ArcGIS Data Appliance World Standard Collection 2; Esri Vector Basemaps, OpenStreetMap Vector
Basemaps, and World Gazetteer

ArcGIS Data Appliance World Advanced Collection 3; Esri Vector Basemaps, OpenStreetMap Vector
Basemaps, and World Gazetteer

ArcGIS Data Appliance North America
Standard

Collection 4; Esri Vector Basemaps, OpenStreetMap Vector
Basemaps, and World Gazetteer

ArcGIS Data Appliance North America
Advanced

Collection 5; Esri Vector Basemaps, OpenStreetMap Vector
Basemaps, and World Gazetteer

ArcGIS Data Appliance: World Gazetteer World Gazetteer

ArcGIS Data Appliance: Esri Vector
Basemaps Esri Vector Basemaps

ArcGIS Data Appliance: OpenStreetMap
Vector Basemaps OpenStreetMap Vector Basemaps

Each of the following product components can be downloaded from My Esri or may ship separately on its own USB
flash drive:
• OSM Vector Basemaps: Basic (WMA only) and its help documentation downloaded from My Esri or on the World

Basic flash drive.

• World Gazetteer.

• Esri Vector Basemaps.

• OpenStreetMap Vector Basemaps.

See ArcGIS Data Appliance 2025 content for more information on the collections and services available with ArcGIS
Data Appliance 2025.

Data Appliance coverage map
As illustrated in the following coverage map, coverage is provided at the following scales:

• World Basic—Worldwide coverage down to ~1:144k.

• World Standard and World Advanced—Worldwide coverage down to largest scale available.

• North America Standard and North America Advanced—Regional coverage down to largest scale available, as
indicated on the inset map; coverage includes United States outlying territories.
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ArcGIS Data Appliance 2025 content
A data appliance collection is a set of hard drives in a RAID array containing data and resources required for
publishing services. Data Appliance collections are composed of the following contents:

Collection Contents

Collection 1
Includes the World Imagery basemap (published as a 2D map service), World Hillshade,
World Hillshade (Dark), and World Ocean Base layers, at small and medium scales down to
1:144,000 (Level [L] 12), where available; and World Elevation (published as a 3D image
service) for the World Basic product option.

Collection 2

Includes the World Imagery basemap (published as a 2D map service), World Hillshade,
World Hillshade (Dark), and World Ocean Base layers with content for the world to 1:1,000,
but with limited availability from 1:9,000 to 1:1,000 (L16–L19); the Arctic and Antarctic
services; World Elevation (published as 2D and 3D image services) and elevation analysis
services for the World Standard product option.

Collection 3
Includes the World Imagery basemap (published as a 2D map service), World Hillshade,
World Hillshade (Dark), and World Ocean Base layers with content for the world to 1:282
(L21), where available; the Arctic and Antarctic services; World Elevation (published as 2D and
3D image services) and elevation analysis services for the World Advanced product option.

Collection 4

Includes the World Imagery basemap (published as a 2D map service), World Hillshade,
World Hillshade (Dark), and World Ocean Base layers with content for North America to
1:1,000, but with limited availability from 1:9,000 to 1:1,000 (L16–L19); World Elevation
(published as 2D and 3D image services) and elevation analysis services for the North
America Standard product option.

Collection 5
Includes the World Imagery basemap (published as a 2D map service), World Hillshade,
World Hillshade (Dark), and World Ocean Base layers with content for North America to 1:282
(L21), where available; World Elevation (published as 2D and 3D image services) and elevation
analysis services for the North America Advanced product option.

Esri Vector
Basemaps

Ships separately on a USB flash drive or may be downloaded from My Esri and includes all
vector basemap styles (published as vector tile layers on a portal) and two vector tile
packages (published as hosted vector tile services) for the World Standard and Advanced,
North America Standard and Advanced, and the Esri Vector Basemaps product option.

OpenStreetMap
Vector
Basemaps

Ships separately on a USB flash drive or may be downloaded from My Esri and includes all
vector basemap styles (published as vector tile layers on a portal) and two vector tile
packages (published as hosted vector tile services) for the World Standard and Advanced,
North America Standard and Advanced, and the OpenStreetMap (OSM) Vector Basemaps
product option.¹

OSM Vector
Basemaps:
Basic (WMA
only)

Ships separately on the World Basic USB flash drive or may be downloaded from My Esri and
includes all OSM Vector Basemaps (WMA only down to 1:144,000) styles (published as vector
tile layers on a portal) and a vector tile package (published as a hosted vector tile service) for
the World Basic product option.¹

World
Gazetteer

Ships separately on a USB flash drive or may be downloaded from My Esri and includes the
World Gazetteer locator for the World Standard and Advanced, North America Standard and
Advanced, and the World Gazetteer product option.

¹ ArcGIS Data Appliance: OpenStreetMap Vector Basemaps is in Mature Support in ArcGIS Data Appliance 2025.
This is the last release for OSM Vector Basemaps. For ArcGIS Data Appliance 2026, OSM Vector Basemaps will be
replaced with Open Basemap Vector Basemaps, which will include open data from OpenStreetMap and other
sources.
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Note:
The Data Appliance Raster Services Help PDF file (arcgis_data_appliance_2025_raster_services_help.pdf)
can be downloaded from My Esri for Collections 1 through 5.

For details on the services available with each product option, see the Data Appliance service summary table below.

Data Appliance service summary
The following tables summarize the differences between the services included with each Data Appliance product
option:

Basemaps

Service Thumbnail Overview

Coverage
for World
Basic
(Collection
1)

Coverage
for World
Standard
(Collection
2)

Coverage
for World
Advanced
(Collection
3)

Coverage
for North
America
Standard
(Collection
4)

Coverage
for North
America
Advanced
(Collection
5)

World
Imagery

Includes
high-
resolution
imagery for
North
America,
Europe, and
other areas
around the
world and
low-
resolution
satellite
imagery for
the rest of
the world.

~1:591M
to
~1:144,000
Global

~1:591M
to
~1:72,000
Global
~1:36,000
to ~1:1,000
Limited
global
coverage
Geographic
coverage
and levels
of detail
for
~1:36,000
to ~1:1,000
is a subset
of what is
included
with World
Advanced.
See the
coverage
map.

~1:591M
to
~1:72,000
Global
~1:36,000
to ~1:282
Limited
global
coverage
~1:36,000
to ~1:282.
Complete
contiguous
United
States,
Australia,
New
Zealand,
and most
of Europe
coverage
where
available.
See the
coverage
map.

~1:591M
to
~1:144,000
Global
~1:36,000
to ~1:1,000
Limited
North
America
coverage
Geographic
coverage
and levels
of detail for
~1:36,000
to ~1:1,000
is a subset
of what is
included
with North
America
Advanced.
See the
coverage
map.

~1:591M
to
~1:144,000
Global
~1:36,000
to
~1:1,000
Complete
contiguous
United
States
coverage
~1:36,000
to ~1:282
Limited
North
America
coverage.
See the
coverage
map.

Service Thumbnail Overview Coverage

Antarctic
Imagery

15-meter TerraColor imagery
designed to be used as a
basemap for overlaying other
data for the Antarctic region.

World Standard (Collection 2) and World
Advanced (Collection 3): ~1:902,000,000 down
to ~1:110,000
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Service Thumbnail Overview Coverage

Arctic
Imagery

15-meter TerraColor imagery
designed to be used as a
basemap for overlaying other
data for the Arctic region.

World Standard (Collection 2) and World
Advanced (Collection 3): ~1:902,000,000 down
to ~1:110,000

Arctic
Ocean
Base

Designed to be used as a
basemap by marine GIS
professionals and as a reference
map by anyone interested in
ocean data.

World Standard (Collection 2) and World
Advanced (Collection 3): ~1:902,000,000 down
to ~1:881,000

World
Hillshade

Portrays elevation as an artistic
hillshade. It was designed to be
used as a backdrop for
topographical, soil, hydro, land
cover, or other outdoor
recreational maps.

World Basic (Collection 1): ~1:591,000,000 to
~1:144,000 Global
World Standard (Collection 2), World Advanced
(Collection 3), North America Standard
(Collection 4), North America Advanced
(Collection 5): ~1:591,000,000 to ~1:144,000
Global; ~1:72,000 to ~1:9,000 Select areas in
United States and Europe

World
Hillshade
(Dark)

Portrays elevation as an artistic
hillshade. It was designed to be
especially useful in building
maps that provide terrain
context while highlighting
feature layers and labels.

World Basic (Collection 1): ~1:591,000,000 to
~1:144,000 Global
World Standard (Collection 2), World Advanced
(Collection 3), North America Standard
(Collection 4), North America Advanced
(Collection 5): ~1:591,000,000 to ~1:144,000
Global; ~1:72,000 to ~1:9,000 Select areas in
United States and Europe

World
Ocean
Base

Map of the oceans showing
bathymetry.

World Basic (Collection 1): ~1:591,000,000 to
1:577,000; ~1:288,000 to ~1:144,000 Limited
global coverage
World Standard (Collection 2), World Advanced
(Collection 3), North America Standard
(Collection 4), North America Advanced
(Collection 5): ~1:591,000,000 to ~1:577,000
Global; ~1:288,000 to ~1:9,000 Limited global
coverage

Reference layers
Service Thumbnail Overview Coverage

Arctic
Ocean
Reference

Designed to be used as the reference layer for the
Arctic Ocean Base map, this reference layer includes
marine water body names, undersea feature names,
and derived depth values in meters.

World Standard (Collection
2), and World Advanced
(Collection 3):
~1:902,000,000 down to
~1:881,000

World Elevation
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Service Thumbnail Overview Coverage

Terrain

World elevation layer composed
of multiresolution and
multisource elevation data (DTM)
that provides access to elevation
values and derivatives such as
slope, aspect, and hillshade to use
in analysis and visualization.

World Standard (Collection 2), World Advanced
(Collection 3), North America Standard
(Collection 4), North America Advanced
(Collection 5): Includes global elevation data
from multiple sources with resolutions ranging
from 1,000 meters globally to 2 meters in a few
regions

Terrain
3D

World elevation surface to use for
oblique viewing in Scenes in
ArcGIS Pro and ArcGIS Online
Scene Viewer.

World Basic (Collection 1), World Standard
(Collection 2), World Advanced (Collection 3),
North America Standard (Collection 4), North
America Advanced (Collection 5): Includes
global elevation data from multiple sources with
resolutions ranging from 1,000 meters globally
to 2 meters in a few regions

Elevation analysis
Data Thumbnail Overview Coverage

Profile

The Profile
geoprocessing tool
calculates profile tables
for lines you specify on a
global elevation dataset.

World Standard (Collection 2), World Advanced
(Collection 3), North America Standard (Collection
4), North America Advanced (Collection 5): Includes
global elevation data from multiple sources, with
resolutions ranging from 1,000 meters globally, 30
meters for most latitudes, and 10 meters in the
continental United States

Viewshed

The Viewshed
geoprocessing tool
creates viewshed
polygons for observation
points you specify on a
global elevation dataset.

World Standard (Collection 2), World Advanced
(Collection 3), North America Standard (Collection
4), North America Advanced (Collection 5): Includes
global elevation data from multiple sources, with
resolutions ranging from 90 meters for most
latitudes, 30 meters for most latitudes, and 10
meters in the continental United States

Summarize
Elevation

The Summarize Elevation
geoprocessing tool
calculates elevation,
slope and aspect
statistics for point, line or
polygon features you
specify on a global
elevation dataset.

World Standard (Collection 2), World Advanced
(Collection 3), North America Standard (Collection
4), North America Advanced (Collection 5): Includes
global elevation data from multiple sources, with
resolutions ranging from 90 meters for most
latitudes, 30 meters for most latitudes, and 10
meters for most latitudes

Locators
Service Overview Coverage

World
Gazetteer

This locator
allows you to
geocode
various types
of places
around the
world.

World Standard, World Advanced, North America Standard, North America
Advanced: References a geodatabase of more than 27 million geographical names
including more than 12 million unique features with roughly 4.8 million populated
places and 15 million alternate names. including countries, states and provinces,
administrative areas (for example, counties), cities, landmarks, water bodies, and
more
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What's new
ArcGIS Data Appliance 2025 includes the following improvements and enhancements:

Note:
ArcGIS Data Appliance provides information about the ArcGIS Data Appliance product options, and ArcGIS Data
Appliance 2025 content includes a table to help you understand the difference between the services in each
product option.

Esri Vector Basemaps
Esri Vector Basemaps, an additional set of basemaps in vector tile format, is available in Web Mercator Auxiliary
Sphere projection and WGS84/GCS tiling scheme; it ships separately on a USB flash drive or can be downloaded
from My Esri with most product options. There are five new vector tile layers (map styles) as well as updates to 54
existing style items. The vector tile packages contain updated global data from a variety of sources including
commercial, authoritative agencies, and open-source providers, as well as local authoritative data from the Esri
Community Maps Program. Vector basemaps can also be customized.

Note:
This feature is not included with the World Basic product option.

OpenStreetMap Vector Basemaps
OpenStreetMap (OSM) Vector Basemaps, an additional set of basemaps in vector tile format, is available in Web
Mercator Auxiliary Sphere projection and WGS84/GCS tiling scheme; it ships separately on a USB flash drive or can
be downloaded from My Esri with most product options. There is one new and 12 updated OSM vector map styles.
The contents of these maps are built from the OpenStreetMap Daylight Distribution data. Vector basemaps can also
be customized.

Note:
OSM Vector Basemaps: Basic (WMA only), a set of basemaps in vector tile format, is included on the ArcGIS Data
Appliance 2025 World Basic USB flash drive (ships separately or downloaded from My Esri) as part of the World
Basic product option.

Note:
ArcGIS Data Appliance: OpenStreetMap Vector Basemaps is in Mature Support in ArcGIS Data Appliance 2025. This
is the last release for OSM Vector Basemaps. For ArcGIS Data Appliance 2026, OSM Vector Basemaps will be
replaced with new Open Basemap Vector Basemaps, which will include open data from OpenStreetMap and other
sources.

World Gazetteer
The World Gazetteer is a places locator that allows you to geocode various types of places around the world. The
World Gazetteer locator is composed solely of open-source content, primarily from GeoNames. The GeoNames
database itself contains more than 27 million geographical names and consists of more than 12 million unique
features with roughly 4.8 million populated places and 15 million alternate names. The gazetteer references a
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dataset including countries, states and provinces, administrative areas (for example, counties), cities, landmarks,
water bodies, and more. It ships separately on a USB flash drive or can be downloaded from My Esri with most
product options.

Note:
World Gazetteer is not included with the World Basic product option.

World Places Locator is no longer included with ArcGIS Data Appliance.

World Imagery
The World Imagery basemap was updated with more recent, higher-accuracy, and more detailed imagery.

World Imagery receives updated high-resolution, commercially licensed content globally and contributions from the
GIS community in select areas. The commercial content is sourced from Maxar's constellation of high-resolution
imaging satellites, while the community contributions are generally high-resolution aerial photography. Additional
information is available in the World Imagery service description and in the associated metadata layer provided with
your source documents.

The following map shows the updated coverage in this release:

License:
Coverage is defined by the product option you licensed.

World Hillshade and World Hillshade (Dark)
The World Hillshade and World Hillshade (Dark) layers were updated with lidar-derived 30-centimeter elevation
data for the Nebraska (USA) counties of Sarpy, Douglas, and Lancaster; 50-centimeter elevation data for Hong Kong
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and Cook County (Illinois, USA); 1-meter elevation data for Slovenia, England, France, Berlin (Germany), Hamburg
(Germany), and parts of Poland, New Zealand, and the United States; 2-meter elevation data for Saxony-Anhalt
(Germany); 5-meter elevation data for New South Wales (Australia) and parts of Poland; and 10-meter elevation
data for Italy and the United States.

This release also includes commercial licensed elevation data from Maxar at 50 centimeters for large parts of Asia
and Africa along with a few areas in Europe, North America, South America, and Australia.

World Elevation
The Terrain 3D layer was updated with lidar-derived 30-centimeter elevation data for the Nebraska (USA) counties
of Sarpy, Douglas, and Lancaster; 50-centimeter elevation data for Hong Kong and Cook County (Illinois, USA);
1-meter elevation data for Slovenia, England, France, Berlin (Germany), Hamburg (Germany), and parts of Poland,
New Zealand, and the United States; 2-meter elevation data for Saxony-Anhalt (Germany); 5-meter elevation data
for New South Wales (Australia) and parts of Poland; and 10-meter elevation data for Italy and the United States.

The Terrain layer was updated with lidar-derived 30-centimeter elevation data for the Nebraska (USA) counties of
Sarpy, Douglas, and Lancaster; 50-centimeter elevation data for Cook County (Illinois, USA); 1-meter elevation data
for England, France, Wales, Bavaria (Germany), Saxony (Germany), Brandenburg (Germany), parts of New Zealand,
and the United States; and 10-meter elevation data for Italy and the United States.

Elevation Analysis
The Profile, Viewshed, and Summarize Elevation geoprocessing tools were updated with 10-meter elevation data for
Italy and the United States along with 30-meter elevation data for the United States, Canada, and Mexico.

In addition, the Profile tool was updated with the GEBCO 2023 grid for the 500 m (15 arc second) DEM Resolution
option.
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Frequently asked questions
Listed below are questions or issues you may encounter when working with ArcGIS Data Appliance 2025 content, as
well as recommended solutions.

• How does ArcGIS Data Appliance work?

• How do I set up ArcGIS Data Appliance?

• What services are available?

• Are there any use restrictions when using services?

• Can I view the metadata for a service?

• Why are my map services missing some tiles at specific levels of detail?

• How do I configure my server to display a Map Data Not Available tile?

• With the announcement that some raster basemaps entered Mature Support in 2021, how does this impact
ArcGIS Data Appliance?

• Which Esri Vector Basemaps are available to replace raster basemaps?

How does ArcGIS Data Appliance work?

ArcGIS Data Appliance contains maps that you can publish on ArcGIS Server. The maps have been cached at a set of
fixed scale levels for optimum performance. Once you publish these maps to your GIS server, you can use them in
any ArcGIS Server client application, such as ArcMap, or web and mobile mapping apps. See Use services for more
information.

How do I set up ArcGIS Data Appliance?

You set up ArcGIS Data Appliance by connecting the appliance to your GIS server and publishing the ArcGIS Data
Appliance maps through ArcGIS Server. The service definitions you'll need to publish, as well as their associated
map caches, are included with each ArcGIS Data Appliance data collection.

If you've published an ArcGIS Server service previously, you may find this process familiar. If you're new to
publishing services or working with ArcGIS Server, you'll find instructions in Set up ArcGIS Data Appliance (new
user).

What services are available?

For a complete list of available services, see the Directory of maps and data.

Are there any use restrictions when using services?

The data is provided by multiple third-party data vendors under license to Esri for inclusion in ArcGIS Data
Appliance for use with Esri software. Redistribution rights are granted by Esri and the data vendor for hard-copy
renditions or static, electronic map images that are plotted, printed, or publicly displayed with proper metadata and
source or copyright attribution to the respective data vendor or vendors. For copyright and attribution information,
see the service description for a specific map service in the Directory of maps and data.
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Can I view the metadata for a service?

Yes. For information about viewing metadata, see one of the following metadata topics:
• Metadata for services in the ArcGIS Server 11.3 help under Manage Services > Publish services

• Metadata for services in the ArcGIS Server 11.2 help under Manage Services > Publish services

• Metadata for services in the ArcGIS Server 11.1 help under Manage Services > Publish services

• Metadata for services in the ArcGIS Server 10.9.1 help under Manage Services > Publish services

Why are my map services missing some tiles at specific levels of detail?

In some cases, when you upgrade ArcGIS Data Appliance from one version to the next, the new service or services
may not recognize all of the new content available on the new version of ArcGIS Data Appliance. You can resolve
this by rebooting the machine where ArcGIS Server is installed after you Delete ArcGIS services from the previous
ArcGIS Data Appliance version.

How do I configure my server to display a Map Data Not Available tile?

There is nothing you need to do. ArcGIS Data Appliance is preconfigured so the ArcGIS Server tile handler
automatically returns a blank or Map Data Not Available tile for empty map areas.

With the announcement that some raster basemaps entered Mature Support in 2021, how does this impact
ArcGIS Data Appliance?

As of 2021, as announced in the Lifecycle for Esri's hosted raster basemap services blog post, the majority of the
raster basemaps on ArcGIS Data Appliance are in Mature Support. This means there will be no additional updates
for those basemaps. This is why ArcGIS Data Appliance: Esri Vector Basemaps are delivered to every ArcGIS Data
Appliance Standard and Advanced customer. Esri Vector Basemaps have full equivalents to the raster basemaps, as
well as numerous offerings that do not exist in raster format. ArcGIS Data Appliance 2022 was the last release to
include updates for those raster basemaps. There are several raster basemaps for imagery and elevation that will
continue to receive updates because there are no vector basemap equivalents.

Which Esri Vector Basemaps are available to replace raster basemaps?

Raster basemap in Mature Support Recommended Esri Vector Basemap equivalent

World Dark Gray Canvas Base and Reference Dark Gray Canvas

World Light Gray Canvas Base and Reference Light Gray Canvas

World Boundaries and Places Hybrid Reference

World Transportation Hybrid Reference

National Geographic World Map National Geographic Style

World Street Map World Street Map

World Topographic Map World Topographic Map
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System requirements
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System requirements for ArcGIS Data Appliance 2025
The system requirements for ArcGIS Data Appliance 2025 are described below.

Requirements for publishing
To host ArcGIS Data Appliance 2025 services, ArcGIS Server 10.9.1, 11.1, 11.2, or 11.3 is required. It must be
installed, configured, and using the latest service packs. If ArcGIS Server is not running, or if you have problems with
the installation, see the following:
• ArcGIS Server 11.3—ArcGIS Server (Windows) installation guide

• ArcGIS Server 11.2—ArcGIS Server (Windows) installation guide

• ArcGIS Server 11.1—ArcGIS Server (Windows) installation guide

• ArcGIS Server 10.9.1—ArcGIS Server (Windows) installation guide

Note:
ArcGIS Data Appliance 2025 is the last release that will include support for ArcGIS Server 10.9.1.

ArcGIS Pro 3.1 or later is needed to publish the map services.

The following services on Collections 1, 2, 3, 4, and 5 have special requirements:

• To publish the Terrain and Terrain3D services, ArcGIS Server 10.9.1 or later with ArcGIS Image Server and ArcGIS
Pro 3.1 or later with a Standard or Advanced license are required.

Note:
The Terrain service is not included with Collection 1.

• To publish the Elevation and ElevationSync geoprocessing services, ArcGIS Server 10.9.1 or later with an
Advanced license and ArcGIS Pro 3.1 or later with a Standard or Advanced license are required.

Note:
The Elevation and ElevationSync geoprocessing services are not included with Collection 1.

Supported system configurations
ArcGIS Data Appliance for Windows is built on Microsoft Windows Storage Server 2019 Standard and Microsoft
Windows Storage Server 2016 Standard.

ArcGIS Server version Operating system Tested

ArcGIS Server 11.3 Windows Server 2022 Standard and Datacenter Yes

ArcGIS Server 11.2 Windows Server 2022 Standard and Datacenter Yes

ArcGIS Server 11.1 Windows Server 2022 Standard and Datacenter Yes

ArcGIS Server 10.9.1 Windows Server 2016 Standard and Datacenter Yes
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Note:
ArcGIS Data Appliance may work in other environments supported by ArcGIS Server; however, ArcGIS Data
Appliance 2025 has not been tested and certified on other environments.

For more information about ArcGIS Server 11.3 system requirements, see ArcGIS Server 11.3 system requirements.

For more information about ArcGIS Server 11.2 system requirements, see ArcGIS Server 11.2 system requirements.

For more information about ArcGIS Server 11.1 system requirements, see ArcGIS Server 11.1 system requirements.

For more information about ArcGIS Server 10.9.1 system requirements, see ArcGIS Server 10.9.1 system
requirements.

For more information about supported system configurations, send an email to Data_Appliance@esri.com.

Esri product teams have a policy of supporting hardware, operating systems, compilers, web browsers, and web
servers. For more information, see Supported Environment Policy.
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Hardware documentation
Hardware documentation for ArcGIS Data Appliance is available on the Arxys website. On the Arxys Support page,
scroll down to the Arxys Support Documentation section, and the documentation is in the ArcGIS Data
Appliance section.
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Set up ArcGIS Data Appliance 2025
You set up ArcGIS Data Appliance by connecting the appliance to ArcGIS Server and publishing the ArcGIS Data
Appliance 2025 maps through ArcGIS Server. You publish the services using the service definition files and their
associated map caches that are included with each data collection.

Before you set up ArcGIS Data Appliance, ensure that you have all the contents in the box that was shipped to you.
For detailed information about what should be included in the box and other hardware information, see the Arxys
website. On the Arxys Support page, scroll down to the Arxys Support Documentation section, and the
documentation is on the ArcGIS Data Appliance tab.

In addition, verify that all the system requirements are met.

Setup instructions vary depending on whether you are a new or existing user; follow the instructions that apply to
you:

• New user

• Existing user
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Set up ArcGIS Data Appliance (new user)
Follow the steps below to complete the ArcGIS Data Appliance 2025 setup process to begin using basemaps.

1. Unpack the components

2. Install the rackmount kit

3. Cable the ArcGIS Data Appliance

4. Power on the server

5. Setup Windows Server

6. Log in to the ArcGIS Data Appliance

7. Update Windows Server

8. Create ArcGIS users on ArcGIS Data Appliance

9. Create shares for the new data collections

10. Configure the cache directories

11. Publish the services

12. Use the services

You can find instructions for steps 1 through 7 in the ArcGIS Data Appliance Quick Start Guide at the Arxys Support
page on its website. Scroll down to the Arxys Support Documentation section, and the documentation is in the
ArcGIS Data Appliance section.

Prerequisites
ArcGIS Server 10.9.1 or later is required for ArcGIS Data Appliance 2025. If you purchased a license for ArcGIS Data
Appliance with ArcGIS Server, install ArcGIS Server before performing the steps. For more information about what's
supported, see System requirements.

Caution:
It is imperative that care and precautions be taken when handling the data collection hard drives.

Step 1: Unpack the components
ArcGIS Data Appliance is shipped with the data collection hard disk drives installed, depending on your product
option. It is recommended that two people remove ArcGIS Data Appliance from its shipping box.

Step 2: Install the rackmount kit
ArcGIS Data Appliance ships with a rackmount rail kit. Remove the hard disk drives from the system before
attempting to install the ArcGIS Data Appliance into a rack. Follow the instructions shipped with the rackmount rail
kit.

Step 3: Cable the ArcGIS Data Appliance
ArcGIS Data Appliance hardware requires two AC power sources. Connect both power cords. Connect a monitor to
the VGA port. Connect a keyboard and mouse to USB ports. Network connectivity is required during the operation

ArcGIS Data Appliance 2025 Raster Services Help

Copyright © 1995-2024 Esri. All rights reserved. 23

https://www.arxys.com/company/support/


of ArcGIS Data Appliance. Plug an Ethernet cable into the Ethernet port of the data appliance. A network cable
should also be connected to the management port for later usage.

Step 4: Power on the server
To power on ArcGIS Data Appliance, press the power button. The Microsoft Windows operating system requires an
initial configuration when used for the first time. Allow the server to boot uninterrupted; it may reboot as the final
configuration is applied to the system.

Step 5: Setup Windows Server
Once the system is done booting, follow the on-screen instructions. Refer to the ArcGIS Data Appliance Quick Start
Guide on the Arxys website for information about activating Windows and for details about system setup.

Step 6: Log in to ArcGIS Data Appliance
Follow the onscreen instructions to log in to ArcGIS Data Appliance.

Step 7: Update Windows Server
ArcGIS Data Appliance ships with the Microsoft Windows Server operating appliance. Microsoft routinely releases
updates and patches to improve stability and security. Any updates released after ArcGIS Data Appliance has
shipped must be applied.

Step 8: Create ArcGIS users on ArcGIS Data Appliance
To create ArcGIS users on ArcGIS Data Appliance, see Create ArcGIS users for instructions.

Step 9: Create shares for the new data collections
To create shares, see Create shares for instructions.

Step 10: Configure the cache directories
To configure the cache directories, see Configure the cache directories for instructions.

Note:
If you're using the World_Imagery service for World Standard or Advanced or North America Standard or Advanced
collections, you also must configure the source documents directories.

Step 11: Publish the services
To publish the services included with ArcGIS Data Appliance, see the following topics:
• Publish basemap and reference layer services

• Publish World Elevation services

• Publish elevation analysis geoprocessing services
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Note:
Optionally, add ExportTiles functionality to download map tiles from the server for offline use.

Step 12: Use the services
See Use services for instructions on how to use the services included with ArcGIS Data Appliance.
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Set up ArcGIS Data Appliance (existing user)
Follow the steps below to complete the ArcGIS Data Appliance 2025 update process for existing ArcGIS Data
Appliance users.

The update process consists of the following steps. For instructions and for help with the services, use the links
below:
1. Unpack the components

2. Delete ArcGIS services from your previous ArcGIS Data Appliance installation

3. Shut down data appliance

4. Remove the old data collection hard drives and install the new ones

5. Power on the server

6. Verify the new data collection hard drives

7. Create shares for the new data collections

8. Configure the cache directories

9. Publish the services

10. Use the services

You can find instructions for steps 1, and 3 through 6 in the ArcGIS Data Appliance Administrator Guide at the Arxys
Support page on its website. Scroll down to the Arxys Support Documentation section, and the documentation is
in the ArcGIS Data Appliance section.

Prerequisites
ArcGIS Server 10.9.1 or later is required for ArcGIS Data Appliance 2025. If you are planning to upgrade to a more
recent version of ArcGIS Server, it is recommended that you do so prior to installing your collections. For more
information on what's supported, see System requirements. Services for ArcGIS Data Appliance data collections that
are installed on your ArcGIS Data Appliance server will be unavailable during the installation process. This update
takes approximately two hours to complete.

Caution:
It is imperative that care and precautions be taken when handling the data collection hard drives.

Step 1: Unpack the components
An ArcGIS Data Appliance update is shipped with the data collection hard disk drives, depending on your product
option.

Step 2: Delete ArcGIS services from your previous ArcGIS Data Appliance
installation
To update ArcGIS Data Appliance, ArcGIS services that use ArcGIS Data Appliance 2024 must be deleted from
ArcGIS Server before you disconnect the hard drives. See Delete ArcGIS services for instructions.
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Note:
After all the services are deleted, reboot the machine where ArcGIS Server is installed.

Legacy:
Do not delete the legacy services if you intend to continue to use these services.

Step 3: Shut down data appliance
Shut down the data appliance. Although the data appliance has hot-swappable hard drive bays, hot swapping an
entire data collection is not supported.

Step 4: Remove the old data collection hard drives and install the new ones
For instructions on how to physically remove the old data collection hard drives and install the new data collection
hard drives, see the sections on removing the old data collection and installing the new data collection in the
ArcGIS Data Appliance Administrator Guide at the Arxys Support page on its website.

Legacy:
Do not unplug the legacy hard drives if you intend to continue to use these services.

Step 5: Power on the server
To turn on ArcGIS Data Appliance, press the power button. The Microsoft Windows Storage Server operating
system performs a number of system checks to verify the integrity of the file system. Allow the data appliance to
boot uninterrupted.

Step 6: Verify the new data collection hard drives
Before using the storage resources provided by ArcGIS Data Appliance, the health of the solid-state disk (SSD), hard
disk drives (HDD), and redundant array of independent disks (RAID) arrays should be verified.

ArcGIS Data Appliance ships with the LSI Storage Authority (LSA) utility pre-installed. This utility is used to verify the
status of the HDDs configured with imagery collections. LSA uses the local web browser. Use any local or domain
administrative account to log in. See the section on checking collection health in the ArcGIS Data Appliance
Administrator Guide at the Arxys Support page on its website.

Step 7: Create shares for the new data collections
To create shares, see Create shares for instructions.

Step 8: Configure the cache directories
To configure the cache directories, see Configure the cache directories for instructions.

Note:
If you're using the World_Imagery service for World Standard or Advanced, or North America Standard or Advanced
collections, you also must configure the source documents directories.
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Step 9: Publish the services
To publish the services included with ArcGIS Data Appliance, see the following topics:
• Publish basemap and reference layer services

• Publish World Elevation services

• Publish elevation analysis geoprocessing services

Note:
Optionally, add ExportTiles functionality to download map tiles from the server for offline use.

Step 10: Use the services
See Use services for instructions on how to use the services included with ArcGIS Data Appliance.
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Delete ArcGIS services
To update to ArcGIS Data Appliance 2025 data collections, ArcGIS services that use the ArcGIS Data Appliance 2024
services must be deleted from ArcGIS Server before you disconnect ArcGIS Data Appliance 2024.

ArcGIS Data Appliance 2024 services
MapServer ImageServer GPServer

Antarctic_Imagery*
Arctic_Imagery*
Arctic_Ocean_Base*
Arctic_Ocean_Reference*
World_Hillshade
World_Hillshade_Dark
World_Imagery
World_Ocean_Base

Terrain**
Terrain3D

Elevation**
ElevationSync**

* These services are not included on Collections 1, 4, or 5.

** These services are not included on Collection 1.

Note:
When you delete a service from ArcGIS Server, any client application using the service can no longer access it.

To delete ArcGIS Data Appliance 2024 services, complete the following steps:

1. Sign in to ArcGIS Server using the ArcGIS Data Appliance data account with administrator privileges.

2. Start Server Manager and sign in using your Primary Site Administrator account.

3. Click Services and click Manage Services.

4. Locate each ArcGIS Data Appliance 2024 service in the Services module and select the services to stop using the
Stop button .

5. Locate each ArcGIS Data Appliance 2024 service in the Services module and click the Delete button to the
right of the listed service name. When the Are you sure you want to delete the service message appears, click
Yes.
The service is deleted from your ArcGIS Server site.

6. After all the services are deleted, reboot the machine where ArcGIS Server is installed.

Now you can disconnect the earlier data appliance and connect the new appliance. For details on how to proceed
with this process, see the data appliance hardware documentation on the Arxys website. Under Arxys Support
Documentation, select the ArcGIS Data Appliance tab.

For more information about deleting ArcGIS services, see the following:
• For ArcGIS Server 11.3, see Delete a service in the ArcGIS Server 11.3 help by clicking Manage Services > Work

with services.
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• For ArcGIS Server 11.2, see Delete a service in the ArcGIS Server 11.2 help by clicking Manage Services > Work
with services.

• For ArcGIS Server 11.1, see Delete a service in the ArcGIS Server 11.1 help by clicking Manage Services > Work
with services.

• For ArcGIS Server 10.9.1, see Delete a service in the ArcGIS Server 10.9 help by clicking Manage Services > Work
with services.
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Create ArcGIS users
The ArcGIS user on ArcGIS Server must be created on ArcGIS Data Appliance. The following instructions are for a
new ArcGIS Data Appliance configuration on Windows:

1. Sign in to ArcGIS Data Appliance as an administrator.

2. Right-click the Start menu and select Computer Management.

3. In the Computer Management application, click Local Users and Groups to expand the tree, and click the Users
directory.

4. In the main pane, right-click and select New User.
The New User wizard pane appears.

5. Use the New User wizard pane to create the user described in the following table. Configure the password to
match the password for the respective account on ArcGIS Server, and set the password to never expire.

Username Full name Description

arcgis ArcGIS Server account Account to perform a variety of functions in support of ArcGIS Server

6. Click Create to create the user on ArcGIS Data Appliance.
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Create shares
ArcGIS Data Appliance 2025 must be configured to share the ArcGIS Data Appliance collections with ArcGIS Server.
The following instructions are for an ArcGIS Data Appliance configuration on Windows:

1. Sign in to ArcGIS Data Appliance as an administrator.

2. Right-click the Start menu and select Computer Management.

3. In the Computer Management application, click Shared Folders to expand the tree, right-click the Shares folder,
and choose New Share.

4. In the Create a Shared Folder Wizard window, click Next to begin.

5. For Folder Path, click Browse, and browse to the hard drive with the ArcGIS Data Appliance collection. Select
the cache directory (or the source_documents directory) to be shared and click OK.

6. Click Next.

7. On the Name, Description, and Settings dialog box, provide the Share name and Description text as
indicated in the following table. For Offline setting, accept the default.
Each product option comes with one collection of drives. Each collection requires uniquely named shares for the
cache and source documents directories. When you enter the share name and description, use the following
naming convention for your cache shares and source document shares according to the product option you
purchased.

Collection Directory Share name Description

\Collection1\cache Collection1_cache Collection 1 Cache
Collection
1 \Collection1\

source_documents Collection1_source_documents Collection 1 Source
Documents

\Collection2\cache Collection2_cache Collection 2 Cache
Collection
2 \Collection2\

source_documents Collection2_source_documents Collection 2 Source
Documents

\Collection3\cache Collection3_cache Collection 3 Cache
Collection
3 \Collection3\

source_documents Collection3_source_documents Collection 3 Source
Documents
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Collection Directory Share name Description

\Collection4\cache Collection4_cache Collection 4 Cache
Collection
4 \Collection4\

source_documents Collection4_source_documents Collection 4 Source
Documents

\Collection5\cache Collection5_cache Collection 5 Cache
Collection
5 \Collection5\

source_documents Collection5_source_documents Collection 5 Source
Documents

8. Click Next.

9. Choose the Customize permissions option and click Custom.
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10. On the Customize Permissions dialog box, click Add.

11. On the Select Users or Groups dialog box, click Advanced.
The Select Users or Groups dialog box expands.
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12. Click Find Now to display a list of all local users. Press the Ctrl key and click the Administrator user and the
arcgis user to highlight them. With both users highlighted, click OK above the Search results area.
The dialog box reverts to a smaller size, and the two users you selected are listed under Enter the object names
to select.

13. Click OK.

14. Ensure that the permissions for the users and groups are set to Full Control.
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15. Repeat steps 3 through 14 to create a share for the source_documents directories for the ArcGIS Data Appliance
collection in your ArcGIS Data Appliance product option.
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Configure the cache directories
ArcGIS Server maintains a list of directories in which it can find map cache tiles. You must explicitly add the ArcGIS
Data Appliance cache directory to this list.

1. Sign in to ArcGIS Server using the ArcGIS Data Appliance data account with administrator privileges.

2. Start Server Manager and sign in using your Primary Site Administrator account.

3. Click the Site tab.

4. On the Server Configuration tab, click Directories.

5. Click the Add Directory button.

6. Provide a name, for example, Collection1_Cache. From the Type list, choose Cache.

7. For Location, provide the path to the cache directory on the ArcGIS Data Appliance collection you made when
you created shares, for example, \\ARCGISDATAAPP\CollectionX_cache, in which X is the number of the
collection you created shares for.
You do not need to specify a Description, Cleaning Mode, or Maximum File Age value.

8. Click Add to add the directory.
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Configure the source documents directories
Caution:

You must complete these steps before you publish the World_Imagery service; otherwise, you cannot view Imagery
Citations.

ArcGIS Server maintains a list of directories in which it can find file geodatabases. If you are publishing the
World_Imagery service for World Standard (on Collection 2), World Advanced (on Collection 3), North America
Standard (on Collection 4), or North America Advanced (on Collection 5), you need to explicitly add the ArcGIS Data
Appliance source documents directories to this list.

Note:
You do not need to perform this step if you are publishing the World_Imagery service for Collection 1 (World Basic).

To configure the directories, complete the following steps:

1. Sign in to ArcGIS Server using the ArcGIS Data Appliance data account with administrator privileges.

2. Start Server Manager and sign in using your Primary Site Administrator account.

3. Click the Site tab.

4. On the Server Configuration tab, click Data Stores.

5. Click the Register drop-down arrow and choose Folder.

6. On the Register Folder dialog box, provide a value in the Name field, for example, Imagery Citations.
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7. For Publisher Folder Path, type \\OriginalServer\source_documents\data.
You do not need to specify a name for Publisher Folder Hostname.

8. For Server Folder Path, uncheck the Same as publisher folder path check box, and provide the path to the
source_documents\data directory on the ArcGIS Data Appliance collection you created when you created
shares, for example, \\ARCGISDATAAPP\CollectionX_source_documents\data, in which X is the number of
the collection you created shares for.

9. Click Create to register the directory.
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Publish basemap and reference layer services
Using ArcGIS Server Manager, you can publish a service definition file (.sd) as a service. The service definition is
uploaded to the server as part of the publishing process. You don't have to copy it to the server first.

To publish a service definition using ArcGIS Server Manager, follow these steps for each service you want to create:

1. Open ArcGIS Server Manager and sign in.

2. Click Services > Manage Services > Publish Service.

3. Browse to CollectionX_source_documents > service_definitions on the ArcGIS Data Appliance data collection,
for example, \\ARCGISDATAAPP\CollectionX_source_documents\service_definitions, where
CollectionX is the number or letters of the ArcGIS Data Appliance collection for your product option.

Note:
If you plan to publish to ArcGIS Server 10.9.1, you should use the service definitions located in the
service_definitions_10 folder. Also, for Terrain3D, a service definition file is no longer used; Terrain3D
publishing steps are provided at the end of this topic.

ArcGIS Data Appliance 2025 service definitions include services as follows:

Map services
• Antarctic_Imagery.sd

• Arctic_Imagery.sd

• Arctic_Ocean_Base.sd

• Arctic_Ocean_Reference.sd

• World_Hillshade.sd

• World_Hillshade_Dark.sd

• World_Imagery.sd

• World_Ocean_Base.sd

Note:
Map services are on the following collections depending on your product option: Collection1 (World Basic),
Collection2 (World Standard), Collection3 (World Advanced), Collection4 (North America Standard), or
Collection5 (North America Advanced). World Basic and North America collections do not include the
Antarctic or Arctic services.

Note:
If you want to view the Citations for the World Imagery map service, you must Configure ArcGIS Server to use
the source documents directories before you publish World_Imagery.sd. This process is not necessary for
the World_Imagery service included with World Basic (on Collection1).

Image services
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• Terrain3D.sd

Note:
If you plan to publish the Terrain3D service, you must have the ArcGIS Image Server installed.

Note:
Image services are on the following collections depending on your product option: Collection1 (World Basic),
Collection2 (World Standard), Collection3 (World Advanced), Collection4 (North America Standard), or
Collection5 (North America Advanced).

Note:
For Terrain3D on ArcGIS Server, a service definition file is no longer used; Terrain3D publishing steps are
provided at the end of this topic.

4. Select the service definition you want to publish, for example, World_Imagery.sd, and click Open.

5. Click Next.

By default, the service definition is published to the server folder specified in the service definition configuration.
You must publish the service definition to this root folder.

6. If Build cache automatically when service starts is checked, uncheck it.
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Note:
It is recommended that all your service names match the names of the service definition file; you should not
change a service name to a different name.

7. Optionally, choose the GIS server cluster that will host the published service definition.
To learn more, see Upgrade a multiple-cluster site for Windows.

8. Click Next.

9. Optionally, choose to enable or disable capabilities for your service definition.
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10. Click Publish to publish the service definition as a service.
The new service appears in the list of available services.

The publishing process uses the first directory in the server's list of cache directories. You need to change it to
the ArcGIS Data Appliance cache directory that was previously created.

11. Click the Stop button to stop the service.

12. Click the Edit button to edit the service properties.

13. Click Caching, and change the cache directory setting to reference the ArcGIS Data Appliance collection, for
example, \\ARCGISDATAAPP\CollectionX_cache, where X is the number of the collection.

14. Click Save to save your changes, and click the Start button to restart the service.

15. Repeat this process for any other map services you want to publish.

Publish Terrain3D on ArcGIS Server
To publish the Terrain3D service on ArcGIS Server, complete the workflows below to edit the paths in the .json file,
register data stores, and publish the .json file using ArcGIS REST administrator. You need ArcGIS Desktop Standard
or Advanced along with ArcGIS Image Server to publish Terrain3D.

Edit the paths in the .json file
When ArcGIS Data Appliance is deployed in your network, the paths for the cache and source documents
directories in the .json file need to be updated.

In the following steps, the server-ip value is the network IP or server name of the data appliance, and
CollectionX is the collection where the Terrain3D service is located: Collection1 (World Basic), Collection2 (World
Standard), Collection3 (World Advanced), Collection4 (North America Standard), or Collection5 (North America
Advanced).

Complete the following steps to update the paths:

1. In a text editor, browse to .\CollectionX_source_documents\Terrain3D_11\JSON and open
Terrain3D.ImageServer.json.

2. Find and replace \\\\server-ip\\CollectionX_cache with \\\\user-server-ip\\CollectionX_cache,
where user-server-ip is the network IP or server name of ArcGIS Data Appliance, and CollectionX is the
collection where the Terrain3D image service is located.
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3. Find and replace \\\\server-ip\\CollectionX_source_documents with \\\\user-server-

ip\\CollectionX_source_documents, where user-server-ip is the network IP or server name of ArcGIS
Data Appliance, and CollectionX is the collection where the Terrain3D image service is located.

Note:
Ensure that the paths contain double backslashes (\\\\).

4. Save the changes.

Register data stores
Complete the following steps to register the data stores for Terrain3D:

1. Sign in to ArcGIS Server using the ArcGIS Data Appliance data account with administrator privileges.

2. Start Server Manager and sign in using your Primary Site Administrator account.

3. Click the Site tab.

4. From the Server Configuration tab, click Data Stores.

5. Click the Register drop-down arrow and choose Folder.

6. Provide a value for the Name parameter, for example, Terrain3D.
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7. For Publisher Folder Path, use \\<server-ip>\CollectionX_source_documents\Terrain3D_11, where
<server-ip> is the network IP or server name of ArcGIS Data Appliance, and CollectionX is the collection
where the Terrain3D image service is located.
You do not need to specify a name for Publisher Folder Hostname or Server Folder Path.

8. Click Create to register the directory.

Publish the .json file using ArcGIS REST administrator
Follow the steps below to publish the \Terrain3D_11\JSON\Terrain3D.ImageServer.json file using ArcGIS
REST administrator.

1. Sign in to the ArcGIS Server Administrator Directory using the URL https://<server name>:6443/arcgis/

admin.

2. Click services to view the available services under the root folder.

3. Click CreateService.
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The Create Service page appears.

4. Copy and paste the contents of Terrain3D.ImageServer.json into the Service (in JSON format) field.
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5. Click Create to complete the publishing of the Terrain3D service.
The Terrain 3D service is ready to use.

Refer to Use the Terrain3D service for instructions on how to use service in ArcGIS Pro, and ArcGIS Online or
Portal for ArcGIS.

For more information about ArcGIS Server 11.3, see Share a service with your ArcGIS organization using Server
Manager in the ArcGIS Server 11.3 help by clicking Manage services > Work with services.

For more information about ArcGIS Server 11.2, see Share a service with your ArcGIS organization using Server
Manager in the ArcGIS Server 11.2 help by clicking Manage services > Work with services.

For more information about ArcGIS Server 11.1, see Share a service with your ArcGIS organization using Server
Manager in the ArcGIS Server 11.1 help by clicking Manage services > Work with services.

For more information about ArcGIS Server 10.9.1, see Share a service with your ArcGIS organization using Server
Manager in the ArcGIS Server 10.9.1 help by clicking Manage services > Work with services.
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Publish the World Elevation services
The World Elevation services—Terrain and Terrain 3D image services—are available with most product options on
Collections 1, 2, 3, 4, and 5. To use the Terrain and Terrain 3D services, you must publish the services on ArcGIS
Server 10.9.1, 11.1, 11.2, or 11.3 with ArcGIS Image Server and ArcGIS Pro 3.1 or later with a Standard or Advanced
license.

Note:
The Terrain service is not included with Collection 1.

Terrain
The components for setting up the Terrain image service are organized under the WorldElevation folder at
\\<server-ip>\CollectionX_source_documents\data, where <server-ip> is the network IP or server name of
the data appliance, and CollectionX is the collection where the World Elevation content is located: Collection2
(World Standard), Collection3 (World Advanced), Collection4 (North America Standard), or Collection5 (North
America Advanced).

Note:
In the following steps, when the UNC path \\<server-ip>\CollectionX_source_documents\data is mentioned,
<server-ip> denotes the network IP or server name of the data appliance, and CollectionX denotes the
collection where the World Elevation content is located.

Use the following workflows to prepare the Terrain content and publish the Terrain image service.

Prepare the Terrain content
The mosaic datasets and auxiliary files are prepared using the default path Y:\WorldElevation, which needs to be
repaired based on the UNC path of the World Elevation content on ArcGIS Data Appliance. In addition, path
information for RasterFunctionTemplates and .json files for publishing need to be updated.

Follow the steps below to repair the paths:

1. Start ArcGIS Pro. On the start page, under New Project, click Map, and provide a name for the project.

2. In Catalog pane, right-click Folders under the Project tab, and click Add Folder Connection. In the Add Folder
Connection dialog box, provide the UNC path of the WorldElevation folder, for example, \\<server-
ip>\CollectionX_source_documents\data\WorldElevation.

3. Click OK.

4. Under Folders, expand the WorldElevation folder in the Catalog. Under scripts, expand
PrepareElevation.tbx, and double-click the Prepare Elevation tool.
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The Prepare Elevation dialog box appears.

5. In the source_documents field, insert the UNC path, for example, \\<server-
ip>\CollectionX_source_documents.

6. Click Run.
This make take a few minutes, and upon successful completion, you see following message:

The tool has repaired paths for the S_EGM2008, D_HollandFix, R_WorldDTMHillshade, and D_WorldDTM
mosaic dataset items which are now pointing to the UNC path. It has also filled in path information for
RasterFunctionTemplates and .json files for publishing.

7. From the Catalog pane, browse to .\WorldElevation\MD\WorldElevation.gdb and expand the
geodatabase. Drag the D_WorldDTM mosaic dataset to the Map window.
It draws as elevation (DTM) for the whole world.
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8. As a quick check, drag the R_WorldDTMHillshade mosaic dataset to the Map window.
You see the hillshade visualization of elevation.
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Publish the Terrain image service
Once the mosaic dataset paths and raster function templates are fixed, you must publish the service.

1. Open ArcGIS Server Manager (https://localhost:6443/arcgis/manager), and sign in with publisher or
administrator credentials. Make sure ArcGIS Server has read permission on the WorldElevation folder and
register the .\WorldElevation folder as Data Store.
a. Click Site > Server Configuration > Data Stores.

b. Click the Register drop-down arrow and choose Folder.

c. In the Register Folder window, fill out the Name and Publisher Folder Path boxes. For Publisher Folder
Path, provide the UNC path of the WorldElevation folder, for example, \\<server-
ip>\CollectionX_source_documents\data\WorldElevation.
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d. For Publisher Folder Hostname, specify the machine that is hosting the publisher's folder.
You can specify the machine name (for example, MyServer), fully qualified domain name (for example,
MyServer.domain.com), IP address (for example, 12.34.56.789), or localhost (localhost).

e. Click Create.
This registers your folder with the server.

f. Click the check box for the folder just registered, and click Validate.
A green check mark under Status indicates that the UNC path is validated by the server.

2. Sign in to the ArcGIS Server Administrator Directory using the URL https://<server name>:6443/arcgis/

admin.
a. Click services to view the available services under the root folder.

b. Click CreateService.
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The Create Service page appears.

c. Copy and paste the contents of .\WorldElevation\Parameter\json\Terrain.txt into the Service (in
JSON format) field.

d. Click Create to complete the publishing of the Terrain service.
The Terrain service is ready to use.

3. To use the Terrain service in ArcGIS Pro, follow these steps.
a. In the ArcGIS Pro Catalog window, right-click New > New Server > New ArcGIS Server.

The Add ArcGIS Server Connection window appears.

b. Provide the server URL where the Terrain service was published and credentials (optional) to make the ArcGIS
Server connection.
A server connection is made.

c. Drag the Terrain service to the Map window from the recently made server connection in the catalog.

d. By default, the service renders as an elevation (DTM) raster.

e. From the Contents pane, right-click Terrain and click Properties > Processing Templates.

f. From the Processing Template drop-down list, choose one of the functions defined on the service.
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g. Click OK.
The Raster function dynamically renders the elevation derivative selected from the drop-down list.

Note:
Slope_Degrees, Slope_Degrees_Map, and Slope_Percent have known issues when published on ArcGIS
Enterprise server 11.0 and 11.1. These functions do not return correct values or render correctly.

4. To use the Terrain service in ArcGIS Online Map Viewer, follow these steps.
a. Go to the REST endpoint where the Terrain service is published, for example, http://localhost:6080/

arcgis/rest/services/Terrain/ImageServer.

b. Click ArcGIS Online Map Viewer.
The Terrain service opens in Map Viewer Classic in a browser. By default, it renders as elevation (DTM).

c. Click Terrain > More Options > Image Display > Renderer to choose from the server functions defined on
the service.

The Raster function dynamically renders the elevation derivative selected from the drop-down list.

Publish the Terrain 3D service
Follow the steps detailed under Publish basemap and reference layer services to publish the Terrain3D service on
your ArcGIS Server installation.
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Publish the elevation analysis geoprocessing services
Elevation analysis geoprocessing services allow you to perform raster analysis on world elevation data. Use the
Profile geoprocessing service tool to create elevation profiles along any given polyline features. Use the Viewshed
geoprocessing service tool to create viewsheds for any given observation point features anywhere on the surface of
the earth. Use the Summarize Elevation tool to calculate summary statistics of elevation, slope, and aspect for any
given point, polyline, or polygon features. To publish the Elevation geoprocessing services, ArcGIS Server 10.9.1 or
later with an Advanced license is required. The data preparation steps below require ArcGIS Pro 3.1 or later with a
Standard or Advanced license.

Tools and data location
The geoprocessing tools and data for setting up the elevation geoprocessing services are organized under the
ElevationGP folder at \\<server-ip>\CollectionX_source_documents\data\WorldElevation, where
<server-ip> is the network IP or server name of the data appliance, and CollectionX is the collection where the
World Elevation content is located: Collection2 (World Standard), Collection3 (World Advanced), Collection4 (North
America Standard), or Collection5 (North America Advanced). The elevation analysis geoprocessing services are not
included with Collection 1.

Note:
In the following steps, when the UNC path \\<server-ip>\CollectionX_source_documents\data is mentioned,
<server-ip> denotes the network IP or server name of the data appliance, and CollectionX denotes the
collection where the World Elevation content is located.

Use the following workflows to publish the Elevation and ElevationSync .json files.

Repair the mosaic dataset paths
The elevation geoprocessing services use a set of derived and referenced mosaic datasets as the elevation data
source. These mosaic datasets were updated for your environment when you previously ran the Prepare Elevation
tool while publishing the Terrain service. In addition, path information has been filled in for configuration and
.json files required for publishing.

Publish the Elevation and ElevationSync .json files
Follow the steps below to publish the Elevation.json and ElevationSync.json files using ArcGIS REST
administrator.

1. Sign in to the ArcGIS Server Administrator Directory using the URL https://<server name>:6443/arcgis/

admin.
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2. Click services to view the available services under the root folder.

3. Click CreateService.

The Create Service page appears.

4. Copy and paste the contents of .\WorldElevation\ElevationGP\json\Elevation.json into the Service (in
JSON format) field.

5. Click Create to complete the publishing of the Elevation geoprocessing service.
The Elevation service is ready to use.

6. Repeat steps 1 through 5 using ElevationSync.json instead of Elevation.json to complete the publishing
of the ElevationSync geoprocessing service.

For information about how to use the elevation analysis services, see Use the elevation analysis geoprocessing
services.
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Add ExportTiles functionality
The ArcGIS client APIs allow apps to download map tiles from the server for offline use.

You can export tiles from an existing tile cache to a new tile cache or a tile package. This functionality is added by
updating the exportTilesAllowed property to true in the service properties.

1. Sign in to the ArcGIS Server Administrator Directory using the URL https://<server name>:6443/arcgis/

admin.

2. Click services to view the available services under the root folder.

3. Click any service that you published to this folder, for example, World_Imagery.

The service properties page appears.

4. Scroll to the bottom of the page and click edit.

5. On the Edit MapServer page, find exportTilesAllowed in the Service Properties text area. Update the
exportTilesAllowed property to true.
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6. Optionally, update the maxExportTilesCount property to 1000000 to export a larger tile package.

7. Click Save Edits to save and restart the service.

The service is now set up so you can export tiles. Repeat these steps for all services from which you want to export
tiles.
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Directory of maps and data
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Directory of maps and data
The following ArcGIS Data Appliance 2025 services are available for you to publish and use with your ArcGIS
applications. Click the service name to view a full service description including copyright and attribution
information.

The services are grouped into the following categories:

• Basemaps—Layers intended to be used on their own or overlaid with other layers

• Reference layers—Layers intended to be overlaid on basemaps to provide reference information

• World Elevation—Elevation layers for analysis and 2D and 3D visualizations

• Elevation analysis—Geoprocessing tools for performing analysis on elevation data

• Locators—Intended for geocoding places

Basemaps

Antarctic Imagery

This map provides 15-meter
TerraColor imagery for the polar
region of Antarctica.

Arctic Imagery

This map provides 15-meter
TerraColor imagery for the Arctic
polar region.

Arctic Ocean Base

This map includes bathymetry
overlaid on land-cover and shaded
relief imagery for the Arctic polar
region.

World Hillshade

This map portrays elevation as an
artistic hillshade.

World Hillshade (Dark)

This map portrays elevation as an
artistic hillshade in a dark color
palette.

World Imagery

This map is a compilation of
satellite and aerial imagery
worldwide.
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World Ocean Base

This map includes bathymetry and
inland waters and roads overlaid
on land-cover and shaded relief
imagery.

Reference layers
Arctic Ocean Reference

This map includes marine water body
names, undersea feature names, and
derived depth values for use with the
Arctic Ocean Base map.

World Elevation
Terrain

This is a world elevation layer composed
of multiresolution and multisource
elevation data (DTM), which provides
access to elevation values and derivatives
such as slope, aspect, and hillshade to use
in analysis and visualization.

Terrain 3D

This is a world elevation surface to use for
oblique viewing in scenes in ArcGIS Pro
and ArcGIS Online Scene Viewer.

Elevation analysis
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Profile

The Profile geoprocessing tool
calculates profile tables for
lines you specify on a global
elevation dataset.

Viewshed

The Viewshed geoprocessing
tool creates viewshed
polygons for observation
points you specify on a global
elevation dataset.

Summarize Elevation

The Summarize Elevation
geoprocessing tool calculates
summary statistics of
elevation, slope, and aspect for
point, polyline, or polygon
features you specify on a
global elevation dataset.

Locators
World Gazetteer
This places locator allows you to geocode
various types of places around the world.
The World Gazetteer references a dataset
including countries, states and provinces,
administrative areas, cities, landmarks,
water bodies, and more.
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Basemaps
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Antarctic Imagery

This map provides 15-meter TerraColor imagery for the polar region of Antarctica.

Map Service Name: Antarctic_Imagery

Note:
The Antarctic Imagery map is not included with Collection 1.

Description
The Antarctic Imagery map is designed to be used as a basemap for overlaying other data for the Antarctic region.
The Antarctic Imagery map includes imagery from 90 to 50 degrees south latitude, though the projection will
support display of data to lower latitudes.

Attribution
Source: Earthstar Geographics

Coordinate system
WGS 1984 Antarctic Polar Stereographic (WKID 3031)

Map service data format
Map server cache in JPEG format

Coverage
Coverage is provided in World Standard (Collection 2) and World Advanced (Collection 3) from ~1:902,590,245
down to ~1:110,179.
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Arctic Imagery

This map provides 15-meter TerraColor imagery for the Arctic polar region.

Map Service Name: Arctic_Imagery

Note:
The Arctic Imagery map is not included with Collection 1.

Description
The Arctic Imagery map is designed to be used as a basemap for overlaying other data for the Arctic region. The
Arctic Imagery map includes imagery from 90 to 50 degrees north latitude, though the projection will support
display of data to lower latitudes.

Attribution
Source: Earthstar Geographics

Coordinate system
Alaska Polar Stereographic (WKID 5936)

Map service data format
Map server cache in JPEG format

Coverage
Coverage is provided in World Standard (Collection 2) and World Advanced (Collection 3) from ~1:902,590,245
down to ~1:110,179.
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Arctic Ocean Base

This map includes bathymetry overlaid on land-cover and shaded relief for the Arctic polar region.

Map Service Name: Arctic_Ocean_Base

Note:
The Arctic Ocean Base map is not included with Collection 1.

Description
The Arctic Ocean Base map features marine bathymetry. This layer is designed to be used as a basemap by marine
GIS professionals and as a reference map by anyone interested in ocean data. Land features include inland waters
and roads overlaid on land-cover and shaded relief imagery. This web map allows you to view the Arctic Ocean Base
with the Arctic Ocean Reference layer drawn on top.

The map was compiled from a variety of best available sources from several data providers, including General
Bathymetric Chart of the Oceans GEBCO_08 Grid version 20100927, the International Bathymetric Chart of the Arctic
Ocean, and the National Oceanic and Atmospheric Administration (NOAA) for the oceans; and Garmin, and Esri for
topographic content.

The Arctic Ocean Base currently provides coverage down to a scale of ~1:881,000. The Arctic Ocean Base can and
will be extended with higher-resolution bathymetric data. You can contribute your bathymetric data to this map and
have it served by Esri for the benefit of the GIS community. For more information about how to contribute data,
contact Oceanbasemapteam@esri.com.

Note:
Data from the GEBCO_08 Grid shall not be used for navigation or for any other purpose relating to safety at sea.
The GEBCO_08 Grid is largely based on a database of ship-track soundings with interpolation between soundings
guided by satellite-derived gravity data. In some areas, data from existing grids are included. The GEBCO_08 Grid
does not contain detailed information in shallower water areas, and information concerning the generation of the
grid can be found on GEBCO website at www.gebco.net/data_and_products/gridded_bathymetry_data/. The
GEBCO_08 Grid is accompanied by a Source Identifier (SID) Grid, which indicates which cells in the GEBCO_08 Grid
are based on soundings or existing grids and which have been interpolated. The latest version of both grids and
accompanying documentation is available to download, on behalf of GEBCO, from the British Oceanographic Data
Centre (BODC) website at www.bodc.ac.uk/data/hosted_data_systems/gebco_gridded_bathymetry_data/. The names
of the IHO (International Hydrographic Organization), IOC (Intergovernmental Oceanographic Commission), GEBCO
(General Bathymetric Chart of the Oceans), NERC (Natural Environment Research Council) or BODC (British
Oceanographic Data Centre) may not be used in any way to imply, directly or otherwise, endorsement or support of
either the Licensee or their mapping system.
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Contributors
The following table names the current Community Maps Program contributors to the Arctic Ocean Basemap hosted
by Esri and provides information on their specific content. The basemap was compiled to uniform cartography using
a variety of best available sources from these data providers.

Contributor Coverage Resolution Scales

General Bathymetric Chart of
the Oceans (GEBCO) Global 927 meters ~1:591,000,000

- 1:577,000

National Oceanic and
Atmospheric Administration US coastal waters, Great Lakes

110 meters
- 40
centimeters

~1:18,000,000
- 1:9,000 in
select areas

Seafloor Mapping Lab of
California State University
Monterey Bay

Southern California coast, Channel Islands 25 meters -
2 meters

~1:288,000 -
1:72,000

Canadian Hydrographic
Service

North Pacific, Queen Charlotte Sound,
Newfoundland Sea, Labrador Sea, and Gulf of
St. Lawrence

250 meters
- 80 meters

~1:4,500,000 -
1:72,000

University of New
Hampshire Center for
Coastal and Marine
Mapping/Joint Hydrographic
Center

Beringian Margin, Bowers Ridge, Necker Ridge,
Line Islands, Mariana Trench, Mendocino Ridge,
Sigsbee Escarpment, Florida Escarpment, and
Atlantic Shelf

180 meters
- 60 meters

~1:2,300,000 -
1:72,000

Geological Survey of Ireland
Western coast of Ireland up to 1,000 miles
offshore, higher-resolution data in nearshore
areas

111 meters,
5 meters

~1:2,300,000 –
1:9,000

OceanWise Coastal waters around the islands of Great
Britain and Ireland 186 meters ~1:4,500,000 –

1:9,000

Attribution
Sources: Esri, GEBCO, NOAA NGDC, Garmin, and other contributors

Coordinate system
Alaska Polar Stereographic (WKID 5936)

Map service data format
Map server cache in JPEG format

Coverage
Coverage is provided in World Standard (Collection 2) and World Advanced (Collection 3) from ~1:902,590,245
down to ~1:881,435.
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World Hillshade

This map portrays elevation as an artistic hillshade.

Map Service Name: World_Hillshade

Description
World Hillshade is designed to be used as a backdrop for topographical, soil, hydro, land cover, or other outdoor
recreational maps.

The map was compiled from a variety of sources from several data providers. The basemap has global coverage
down to a scale of ~1:144,000. In parts of North America, Asia, Africa, Europe, and Oceania, coverage is provided
down to ~1:9,000.

Attribution
Sources: Maxar, Airbus, USGS, NGA, NASA, CGIAR, NLS, OS, NMA, Geodatastyrelsen, GSA, GSI, Intermap, and the
GIS User Community

Coordinate system
Web Mercator Auxiliary Sphere (WKID 102100)

Tiling scheme
Web Mercator Auxiliary Sphere

Map service data format
Map server cache in JPEG format

Coverage
As illustrated in the coverage map, coverage is provided at the following scales:
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World Basic (Collection 1)
~1:591,000,000 down to ~1:144,000 worldwide

World Standard (Collection 2) and World Advanced (Collection 3)
• ~1:591,000,000 down to ~1:144,000 worldwide

• ~1:72,000 to ~1:9,000 in select areas in North America, Asia, Africa, Europe, and Oceania

North America Standard (Collection 4) and North America Advanced (Collection 5)
• ~1:591,000,000 down to ~1:144,000

• ~1:72,000 down to ~1:9,000 in select areas

ArcGIS Data Appliance 2025 Raster Services Help

Copyright © 1995-2024 Esri. All rights reserved. 69



World Hillshade (Dark)

This map portrays elevation as an artistic hillshade in a dark color palette and provides terrain context while
highlighting feature layers and labels.

Map Service Name: World_Hillshade_Dark

Description
The map was compiled from a variety of sources from several data providers. The basemap has global coverage
down to a scale of ~1:144,000. In parts of North America, Asia, Africa, Europe, and Oceania, coverage is provided
down to ~1:9,000.

This dark version of World Hillshade is especially useful in building maps that provide terrain context while
highlighting feature layers and labels.

Attribution
Sources: Maxar, Airbus, USGS, NGA, NASA, CGIAR, NLS, OS, NMA, Geodatastyrelsen, GSA, GSI, Intermap, and the
GIS User Community

Coordinate system
Web Mercator Auxiliary Sphere (WKID 102100)

Tiling scheme
Web Mercator Auxiliary Sphere

Map service data format
Map server cache in JPEG format

Coverage
As illustrated in the coverage map below, coverage is provided at the following scales:
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World Basic (Collection 1)
~1:591,000,000 down to ~1:144,000 worldwide

World Standard (Collection 2) and World Advanced (Collection 3)
• ~1:591,000,000 down to ~1:144,000 worldwide

• ~1:72,000 to ~1:9,000 in select areas in the United States and Europe

North America Standard (Collection 4) and North America Advanced (Collection 5)
• ~1:591,000,000 down to ~1:144,000

• ~1:72,000 down to ~1:9,000 in select areas
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World Imagery

This map is a compilation of satellite and aerial imagery worldwide.

Map Service Name: World_Imagery

Description
World Imagery provides 1-meter or better satellite and aerial imagery for most of the world's landmass and lower-
resolution satellite imagery worldwide. The map is currently comprised of the following sources:

• Worldwide 15-meter resolution TerraColor imagery at small and medium map scales.

• Maxar imagery basemap products around the world: Vivid Premium at 15-centimeter high-definition (HD)
resolution for select metropolitan areas, Vivid Advanced 30-centimeter HD for more than 1,000 metropolitan
areas, and Vivid Standard from 1.2-meter to 0.6-centimeter resolution for the most of the world, with
30-centimeter HD across the United States and parts of Western Europe. More information on the Maxar
products is included below.

• High-resolution aerial photography contributed by the GIS User Community. This imagery ranges from
30-centimeter to 3-centimeter resolution. You can contribute your imagery to this map and have it served by Esri
through the Community Maps Program.

Maxar basemap products
Maxar imagery basemap products include Vivid Premium, Vivid Advanced, and Vivid Standard.

Vivid Premium

This basemap provides committed image currency in a high-resolution, high-quality image layer over defined
metropolitan and high-interest areas across the globe. The product provides 15-centimeter HD resolution imagery.

Vivid Advanced

This basemap provides committed image currency in a high-resolution, high-quality image layer over defined
metropolitan and high-interest areas across the globe. The product includes a mix of native 30-centimeter and
30-centimeter HD resolution imagery.

Vivid Standard

This basemap provides a visually consistent and continuous image layer over large areas through advanced image
mosaicking techniques, including tonal balancing and seamline blending across thousands of image strips. Available
from 1.2-meter down to 30-centimeter HD.

See the Maxar blog, Introducing HD: See More, Do More with High-Definition Imagery, for more information.
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Attribution
Sources: Esri, Maxar, Earthstar Geographics, and the GIS User Community

Coordinate system
Web Mercator Auxiliary Sphere (WKID 102100)

Tiling scheme
Web Mercator Auxiliary Sphere

Map service data format
Map server cache in JPEG format

Metadata
When the data appliance is installed, citation data (also known as metadata) is automatically exposed through the
REST endpoint for the World_Imagery service. These are not feature services but rather feature layers within a map
service. The key difference is that feature layers can be queried, but they cannot be edited. In ArcGIS Pro, use the
Explore tool on the Map tab to see the resolution, collection date, and source of the imagery at the location you
click. In Map Viewer, with pop-ups enabled on the layer, click the location to identify the source information. In
ArcMap, use the Identify tool to identify the source information at the location you click. Values of 99999 mean
that metadata is not available for that field. The metadata applies only to the best available imagery at that location.
You may need to zoom in to view the best available imagery.

You can view the citation layer at http://<services.arcgisonline.com>/arcgis/rest/services/
World_Imagery/MapServer/4 (substitute <services.arcgisonline.com> with the local ArcGIS server name).

Coverage
As illustrated in the coverage maps below, worldwide coverage is provided in World Basic (Collection 1) down to
~1:144,000; World Standard (Collection 2) down to ~1:1,000, and World Advanced (Collection 3) down to ~282; and
regional coverage is provided in North America Standard (Collection 4) down to ~1:1,000, and North America
Advanced (Collection 5) down to ~282.
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Scale (Level) Standard Advanced

1:4,000 (Level 17)

1:2,000 (Level 18)

1:1,000 (Level 19)
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Scale (Level) Standard Advanced

1:600 (Level 20) Not available

1:282 (Level 21) Not available

Larger-coverage maps for Standard and Advanced Imagery are available below.

Standard Imagery coverage maps
The following coverage maps are applicable to both World and North America Standard.

Standard Imagery coverage map at 1:4,000 (Level 17)
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Standard Imagery coverage map at 1:2,000 (Level 18)

Standard Imagery coverage map at 1:1,000 (Level 19)

Advanced Imagery coverage maps
The following coverage maps are applicable to both World and North America Advanced.
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Advanced Imagery coverage map at 1:4,000 (Level 17)

Advanced Imagery coverage map at 1:2,000 (Level 18)
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Advanced Imagery coverage map at 1:1,000 (Level 19)

Advanced Imagery coverage map at 1:600 (Level 20)
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Advanced Imagery coverage map at 1:282 (Level 21)
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World Ocean Base

This map includes bathymetry and inland waters and roads, overlaid on land-cover and shaded relief imagery.

Map Service Name: World_Ocean_Base

Description
This map is designed to be used as a basemap by marine GIS professionals and as a reference map by anyone
interested in ocean data. The basemap features marine bathymetry. Land features include inland waters and roads
overlaid on land cover and shaded relief imagery.

The map was compiled from a variety of best available sources from several data providers, including General
Bathymetric Chart of the Oceans GEBCO_08 Grid, National Oceanic and Atmospheric Administration (NOAA),
National Geographic, Garmin, Geonames.org, Esri, and various other contributors. The basemap was designed and
developed by Esri.

Note:
Data from the GEBCO_08 Grid shall not be used for navigation or for any other purpose relating to safety at sea.
The GEBCO_08 Grid is largely based on a database of ship-track soundings with interpolation between soundings
guided by satellite-derived gravity data. In some areas, data from existing grids are included. The GEBCO_08 Grid
does not contain detailed information in shallower water areas, and information concerning the generation of the
grid can be found on GEBCO website at www.gebco.net/data_and_products/gridded_bathymetry_data/. The
GEBCO_08 Grid is accompanied by a Source Identifier (SID) Grid, which indicates which cells in the GEBCO_08 Grid
are based on soundings or existing grids and which have been interpolated. The latest version of both grids and
accompanying documentation is available to download, on behalf of GEBCO, from the British Oceanographic Data
Centre (BODC) website at www.bodc.ac.uk/data/hosted_data_systems/gebco_gridded_bathymetry_data/. The names
of the IHO (International Hydrographic Organization), IOC (Intergovernmental Oceanographic Commission), GEBCO
(General Bathymetric Chart of the Oceans), NERC (Natural Environment Research Council) or BODC (British
Oceanographic Data Centre) may not be used in any way to imply, directly or otherwise, endorsement or support of
either the Licensee or their mapping system.

Contributors
The following table names the current Community Maps Program contributors to the World Ocean Basemap hosted
by Esri and provides information on their specific content. The basemap was compiled to uniform cartography using
a variety of best available sources from these data providers.

Contributor Coverage Resolution Scales

General Bathymetric Chart of
the Oceans (GEBCO) Global 927 meters ~1:591,000,000

- 1:577,000

ArcGIS Data Appliance 2025 Raster Services Help

Copyright © 1995-2024 Esri. All rights reserved. 80

https://www.gebco.net/data_and_products/gridded_bathymetry_data/
https://www.bodc.ac.uk/data/hosted_data_systems/gebco_gridded_bathymetry_data/


Contributor Coverage Resolution Scales

National Oceanic and
Atmospheric Administration US coastal waters, Great Lakes

110 meters
- 40
centimeters

~1:18,000,000
- 1:9,000 in
select areas

Geoscience Australia Australian coastal waters
~1:9,000,000 –
1:72,000 in
select areas

Seafloor Mapping Lab of
California State University
Monterey Bay

Southern California coast, Channel Islands 25 meters -
2 meters

~1:288,000 -
1:72,000

Canadian Hydrographic
Service

North Pacific, Queen Charlotte Sound,
Newfoundland Sea, Labrador Sea, and Gulf of
St. Lawrence

250 meters
- 80 meters

~1:4,500,000 -
1:72,000

University of New
Hampshire Center for
Coastal and Marine
Mapping/Joint Hydrographic
Center

Beringian Margin, Bowers Ridge, Necker Ridge,
Line Islands, Mariana Trench, Mendocino Ridge,
Sigsbee Escarpment, Florida Escarpment, and
Atlantic Shelf

180 meters
- 60 meters

~1:2,300,000 -
1:72,000

Davey Jones' Locker Seafloor
Mapping/Marine GIS at
Oregon State University

American Samoa 200 meters ~1:2,300,000 -
1:72,000

National Institute of Water
and Atmospheric Research
Ltd (NIWA)

New Zealand, higher-resolution data of Hauraki
Gulf and Cook Strait

250 meters,
20 meters

~1:4,500,000 –
1:72,000

Geological Survey of Ireland
Western coast of Ireland up to 1,000 miles
offshore, higher-resolution data in nearshore
areas

111 meters,
5 meters

~1:2,300,000 –
1:9,000

OceanWise Coastal waters around the islands of Great
Britain and Ireland 186 meters ~1:4,500,000 –

1:9,000

Khaled bin Sultan Living
Oceans Foundation Red Sea

2.5 meters
- 7.5
meters

~1:288,000 -
1:9,000 in
select areas

University of Hawaii School
of Ocean and Earth Science
and Technology

Hawaiian Islands 50 meters
~1:288,000 -
1:9,000 in
select areas

Attribution
Sources: Esri, Garmin, GEBCO, NOAA NGDC, and other contributors

Coordinate system
Web Mercator Auxiliary Sphere (WKID 102100)

Tiling scheme
Web Mercator Auxiliary Sphere

Map service data format
Map server cache in JPEG format
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Coverage
Coverage is provided at the following scales:

World Basic (Collection 1)
~1:591,000,000 to 1:577,000 worldwide; ~1:288,000 to ~1:144,000 in select areas

World Standard (Collection 2) and World Advanced (Collection 3)
~1:591,000,000 to ~1:577,000 worldwide; ~1:288,000 to ~1:9,000 in limited areas based on regional hydrographic
survey data

North America Standard (Collection 4), North America Advanced (Collection 5)
Regional coverage from ~1:591,000,000 to ~1:9,000 in limited areas based on regional hydrographic survey data
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Reference layers
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Arctic Ocean Reference

This map includes marine water body names, undersea feature names, and derived depth values for use with the
Arctic Ocean Base map.

Map Service Name: Arctic_Ocean_Reference

Note:
The Arctic Ocean Reference layer is not included with Collection 1.

Description
The Arctic Ocean Reference layer is designed to be used as the reference layer for the Arctic Ocean Base map. The
reference layer includes marine water body names, undersea feature names, and derived depth values in meters.
Features over land include administrative boundaries and labels and cities.

The reference layer was compiled from a variety of best available sources from several data providers, including
General Bathymetric Chart of the Oceans GEBCO_08 Grid, IHO-IOC GEBCO Gazetteer of Undersea Feature Names
August 2010 version (www.gebco.net), the National Oceanic and Atmospheric Administration (NOAA), and National
Geographic, Garmin, Geonames.org, and Esri, and various other contributors. For details on the Community users
who contributed bathymetric data for this map through the Community Maps Program, see Contributors in the
Arctic Ocean Base description.

The Arctic Ocean Reference map currently provides coverage down to a scale of ~1:881,000. The Arctic Ocean
Reference map can and will be extended with higher-resolution bathymetric data. You can contribute your
bathymetric data to this map and have it served by Esri for the benefit of the GIS community. For more information
on how to contribute data, contact Oceanbasemapteam@esri.com.

Note:
Data from the GEBCO_08 Grid shall not be used for navigation or for any other purpose relating to safety at sea.
The GEBCO_08 Grid is largely based on a database of ship-track soundings with interpolation between soundings
guided by satellite-derived gravity data. In some areas, data from existing grids are included. The GEBCO_08 Grid
does not contain detailed information in shallower water areas, and information concerning the generation of the
grid can be found on GEBCO website at www.gebco.net/data_and_products/gridded_bathymetry_data/. The
GEBCO_08 Grid is accompanied by a Source Identifier (SID) Grid, which indicates which cells in the GEBCO_08 Grid
are based on soundings or existing grids and which have been interpolated. The latest version of both grids and
accompanying documentation is available to download, on behalf of GEBCO, from the British Oceanographic Data
Centre (BODC) website at www.bodc.ac.uk/data/hosted_data_systems/gebco_gridded_bathymetry_data/. The names
of the IHO (International Hydrographic Organization), IOC (Intergovernmental Oceanographic Commission), GEBCO
(General Bathymetric Chart of the Oceans), NERC (Natural Environment Research Council) or BODC (British
Oceanographic Data Centre) may not be used in any way to imply, directly or otherwise, endorsement or support of
either the Licensee or their mapping system.
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Attribution
Sources: Esri, GEBCO, NOAA, National Geographic, Garmin, Geonames.org, and other contributors

Coordinate system
Alaska Polar Stereographic (WKID 5936)

Map service data format
Map server cache in PNG32 format

Coverage
Coverage is provided in World Standard (Collection 2) and World Advanced (Collection 3) from ~1:902,590,245
down to ~1:881,435.
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World Elevation
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Terrain

The Terrain multiresolution layer provides access to elevation values for use in analysis with functions for slope,
aspect, and hillshade.

Service Name: Terrain

Note:
The Terrain service is not included with Collection 1.

Description
This dynamic image service provides numeric values representing ground surface heights based on a digital terrain
model (DTM). The ground heights are based on multiple sources. Heights are orthometric (sea level = 0), and water
bodies that are above sea level have approximated nominal water heights.

This layer is generally not optimal for direct visualization. By default, 32-bit floating point values are returned,
resulting in higher bandwidth requirements. Therefore, usage should be limited to applications that require
elevation data values. Alternatively, client applications can select from numerous additional functions, applied on
the server, that return rendered data. For visualizations such as hillshade, elevation tinted hillshade, and slope,
consider using the appropriate server-side function defined on this service.

Server functions
This layer has server functions defined for the following elevation derivatives:
• Slope Degrees

• Slope Percentage

• Aspect

• Ellipsoidal Height

• Hillshade

• Multi-Directional Hillshade

• Elevation Tinted Hillshade

• Slope Map

• Aspect Map

Data sources
The data for this layer comes from the multiple sources listed below, with original source data in its native
coordinate system. Depending on the scale being viewed, data from one of these datasets is returned.
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Data Source native pixel size
Approximate
pixel size
(meters)

Coverage Primary source Country/
Region

Australia 1m 1 meter 1 Partial areas
of Australia Geoscience Australia Australia

Moreton
Bay,
Australia 1m

1 meter 1
Moreton Bay
region,
Australia

Moreton Bay Regional
Council Australia

New South
Wales,
Australia 5m

5 meters 5
New South
Wales State,
Australia

DFSI Australia

SRTM 1 arc
second
DEM-S

0.0002777777777779
degrees 31 Australia Geoscience Australia Australia

Burgenland
50cm 0.5 meters 0.5 Burgenland

State, Austria Land Burgenland Austria

Upper
Austria 50cm 0.5 meters 0.5 Upper Austria

State, Austria Land Oberösterreich Austria

Austria 1m 1 meter 1 Austria BEV Austria

Austria 10m 10 meters 10 Austria Geoland Austria

Canada
HRDEM 1m 1 meter 1

Partial areas
of the
southern part
of Canada

Natural Resources
Canada Canada

Canada
HRDEM 2m 2 meters 2

Partial areas
of the
southern part
of Canada

Natural Resources
Canada Canada

Denmark
40cm 0.4 meters 0.4 Denmark KDS Denmark

Denmark
10m 10 meters 10 Denmark KDS Denmark

England 1m 1 meter 1 70 percent of
England Environment Agency England

Estonia 1m 1 meter 1 Estonia Estonian Land Board Estonia

Estonia 5m 5 meters 5 Estonia Estonian Land Board Estonia

Estonia 10m 10 meters 10 Estonia Estonian Land Board Estonia

Finland 2m 2 meters 2 Finland NLS Finland

Finland 10m 10 meters 10 Finland NLS Finland

France 1m 1 meter 1 France IGN-F France

Bavaria 1m 1 meter 1 Bavaria State,
Germany

Bayerische
Vermessungsverwaltung Germany
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https://geodaten.bgld.gv.at/de/home.html
https://www.land-oberoesterreich.gv.at/
https://data.bev.gv.at/
https://www.geoland.at/
https://open.canada.ca/
https://open.canada.ca/
https://open.canada.ca/
https://open.canada.ca/
https://www.eng.klimadatastyrelsen.dk/
https://www.eng.klimadatastyrelsen.dk/
https://www.gov.uk/government/organisations/environment-agency
https://geoportaal.maaamet.ee/
https://geoportaal.maaamet.ee/
https://geoportaal.maaamet.ee/
https://www.maanmittauslaitos.fi/en/e-services/mapsite
https://www.maanmittauslaitos.fi/en/e-services/mapsite
https://geoservices.ign.fr/rgealti
https://geodaten.bayern.de/opengeodata/
https://geodaten.bayern.de/opengeodata/


Data Source native pixel size
Approximate
pixel size
(meters)

Coverage Primary source Country/
Region

Berlin 1m 1 meter 1 Berlin State,
Germany Geoportal Berlin Germany

Brandenburg
1m 1 meter 1

Brandenburg
State,
Germany

GeoBasis-DE/LGB Germany

Hamburg
1m 1 meter 1

Hamburg
State,
Germany

LGV Hamburg Germany

Nordrhein-
Westfalen
1m

1 meter 1
Nordrhein-
Westfalen
State,
Germany

Land NRW Germany

Saxony 1m 1 meter 1 Saxony State,
Germany

Landesamt für
Geobasisinformation
Sachsen (GeoSN)

Germany

Sachsen-
Anhalt 2m 2 meters 2

Sachsen-
Anhalt State,
Germany

LVermGeo LSA Germany

Hong Kong
50cm 0.5 meter 0.5 Hong Kong CEDD Hong Kong

Italy
TINITALY
10m

10 meters 10 Italy INGV Italy

Japan
DEM5A,
DEM5B

0.000055555555
degrees 5 Partial areas

of Japan GSI Japan

Japan
DEM10B

0.00011111111
degrees 10 Japan GSI Japan

Latvia 1m 1 meter 1 Latvia Latvian Geospatial
Information Agency Latvia

Latvia 10m 10 meters 10 Latvia Latvian Geospatial
Information Agency Latvia

Latvia 20m 20 meters 20 Latvia Latvian Geospatial
Information Agency Latvia

Lithuania 1m 1 meter 1 Lithuania NZT Lithuania

Lithuania
10m 10 meters 10 Lithuania NZT Lithuania

Netherlands
(AHN3/
AHN4) 50cm

0.5 meter 0.5 Netherlands AHN Netherlands

Netherlands
(AHN3/
AHN4) 10m

10 meters 10 Netherlands AHN Netherlands

ArcGIS Data Appliance 2025 Raster Services Help

Copyright © 1995-2024 Esri. All rights reserved. 89

https://www.berlin.de/sen/sbw/stadtdaten/geoportal/
https://geobasis-bb.de/lgb/de/
https://transparenz.hamburg.de/
https://www.opengeodata.nrw.de/
https://www.geodaten.sachsen.de/
https://www.geodaten.sachsen.de/
https://www.geodaten.sachsen.de/
https://www.lvermgeo.sachsen-anhalt.de/gdp-das-lvermgeo.html
https://portal.csdi.gov.hk/csdi-webpage/
https://tinitaly.pi.ingv.it/
https://www.gsi.go.jp/ENGLISH/index.html
https://www.gsi.go.jp/ENGLISH/index.html
https://www.lgia.gov.lv/
https://www.lgia.gov.lv/
https://www.lgia.gov.lv/
https://www.lgia.gov.lv/
https://www.lgia.gov.lv/
https://www.lgia.gov.lv/
https://www.nzt.lt/
https://www.nzt.lt/
https://www.ahn.nl/
https://www.ahn.nl/


Data Source native pixel size
Approximate
pixel size
(meters)

Coverage Primary source Country/
Region

New
Zealand 1m 1 meter 1

Partial areas
of New
Zealand

Land Information New
Zealand New Zealand

Northern
Ireland 10m 10 meters 10 Northern

Ireland OSNI Northern
Ireland

Norway 10m 10 meters 10 Norway NMA Norway

Poland 1m 1 meter 1 Partial areas
of Poland GIGIK Poland

Poland 5m 5 meters 5 Partial areas
of Poland GIGIK Poland

Scotland 1m 1 meter 1 Partial areas
of Scotland

Scottish Government et
al. Scotland

Slovakia
10m 10 meters 10 Slovakia GKÚ Slovakia

Slovenia 1m 1 meter 1 Slovenia ARSO Slovenia

Madrid City
1m 1 meter 1 Madrid city,

Spain
Ayuntamiento de
Madrid Spain

Spain 2m
(MDT02
2019 CC-BY
4.0 scne.es)

2 meters 2 Partial areas
of Spain IGN Spain

Spain 5m 5 meters 5 Spain IGN Spain

Spain 10m 10 meters 10 Spain IGN Spain

Varnamo
50cm 0.5 meters 0.5

Varnamo
municipality,
Sweden

Värnamo Kommun Sweden

Canton of
Basel-
Landschaft
25cm

0.25 meters 0.25
Canton of
Basel-
Landschaft,
Switzerland

Geoinformation Kanton
Basel-Landschaft Switzerland

Grand
Geneva
50cm

0.5 meters 0.5

Grand
Geneva
metropolitan,
France/
Switzerland

SITG Switzerland
and France

Switzerland
swissALTI3D
50cm

0.5 meters 0.5
Switzerland
and
Liechtenstein

swisstopo
Switzerland
and
Liechtenstein

Switzerland
swissALTI3D
10m

10 meters 10
Switzerland
and
Liechtenstein

swisstopo
Switzerland
and
Liechtenstein
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https://www.linz.govt.nz/data/licensing-and-using-data/attributing-elevation-or-aerial-imagery-data
https://www.linz.govt.nz/data/licensing-and-using-data/attributing-elevation-or-aerial-imagery-data
https://www.opendatani.gov.uk/
https://kartkatalog.geonorge.no/
https://www.geoportal.gov.pl/
https://www.geoportal.gov.pl/
https://remotesensingdata.gov.scot/
https://remotesensingdata.gov.scot/
https://www.gku.sk/gku/
https://gis.arso.gov.si/geoportal/catalog/main/home.page
https://www.madrid.es/portal/site/munimadrid
https://www.madrid.es/portal/site/munimadrid
https://www.ign.es/
https://www.ign.es/
https://www.ign.es/
https://www.varnamo.se/
https://www.baselland.ch/
https://www.baselland.ch/
https://ge.ch/sitg/
https://www.swisstopo.admin.ch/
https://www.swisstopo.admin.ch/


Data Source native pixel size
Approximate
pixel size
(meters)

Coverage Primary source Country/
Region

OS Terrain
50 50 meters 50 United

Kingdom Ordnance Survey United
Kingdom

Douglas
County 1ft 1 foot 0.3048

Douglas
County,
Nebraska,
USA

Douglas County NE United
States

Lancaster
County 1ft 1 foot 0.3048

Lancaster
County,
Nebraska,
USA

Lancaster County NE United
States

Sarpy
County 1ft 1 foot 0.3048

Sarpy County,
Nebraska,
USA

Sarpy County NE United
States

Cook County
1.5 ft 1.5 foot 0.46 Cook County,

Illinois, USA ISGS United
States

3DEP 1m 1 meter 1

Partial areas
of the
conterminous
United States,
Puerto Rico

USGS United
States

NRCS 1m 1 meter 1
Partial areas
of the
conterminous
United States

NRCS USDA United
States

FEMA LiDAR
DTM 3 meters 3

Partial areas
of the
conterminous
United States

FEMA United
States

NED 1/9 arc
second

0.000030864197530866
degrees 3

Partial areas
of the
conterminous
United States

USGS United
States

3DEP 5m 5 meters 5 Alaska,
United States USGS United

States

NED 1/3 arc
second

0.000092592592593
degrees 10

Conterminous
United States,
Hawaii,
Alaska,
Puerto Rico,
and Territorial
Islands of the
United States

USGS United
States
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https://www.ordnancesurvey.co.uk/business-government/products/terrain-50
https://www.douglascounty-ne.gov/
https://www.lincoln.ne.gov/Home
https://www.sarpy.gov/
https://clearinghouse.isgs.illinois.edu/
https://nationalmap.gov/3DEP/
https://www.nrcs.usda.gov/
https://www.fema.gov/
https://nationalmap.gov/3DEP/
https://nationalmap.gov/3DEP/
https://nationalmap.gov/3DEP/


Data Source native pixel size
Approximate
pixel size
(meters)

Coverage Primary source Country/
Region

NED 1 arc
second

0.0002777777777779
degrees 31

Conterminous
United States,
Hawaii,
Alaska,
Puerto Rico,
Territorial
Islands of the
United States;
Canada and
Mexico

USGS United
States

NED 2 arc
second

0.000555555555556
degrees 62 Alaska,

United States USGS United
States

Wales 1m 1 meter 1 Wales Welsh Government Wales

SRTM 1 arc
second

0.0002777777777779
degrees 31

All land areas
between 60
degrees north
and 56
degrees
south except
Australia

NASA World

EarthEnv-
DEM90

0.00083333333333333
degrees 93 Global N Robinson,NCEAS World

SRTM v4.1 0.00083333333333333
degrees 93

All land areas
between 60
degrees north
and 56
degrees
south except
Australia

CGIAR-CSI World

GMTED2010
7.5 arc
second

0.00208333333333333
degrees 232 Global USGS World

GMTED2010
15 arc
second

0.00416666666666666
degrees 464 Global USGS World

GMTED2010
30 arc
second

0.0083333333333333
degrees 928 Global USGS World

For more information, see Use the Terrain service.

Mosaic method
This image service uses a default mosaic method of By Attribute, using Field Best and target of 0. Each of the rasters
has been attributed with Best field value that is generally a function of the pixel size such that higher-resolution
datasets are displayed at higher priority. Other mosaic methods can be set, but care should be taken because the
order of the rasters may change. Where required, queries can also be set to display only specific datasets, such as
only National Elevation Dataset (NED), or the lock raster mosaic rule used to lock to a specific dataset.
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https://nationalmap.gov/3DEP/
https://nationalmap.gov/3DEP/
https://datamap.gov.wales/
https://cmr.earthdata.nasa.gov/search/concepts/C1220567890-USGS_LTA.html
https://www.earthenv.org/DEM.html
https://cgiarcsi.community/data/srtm-90m-digital-elevation-database-v4-1/
https://pubs.usgs.gov/of/2011/1073/
https://pubs.usgs.gov/of/2011/1073/
https://pubs.usgs.gov/of/2011/1073/


Accuracy
The accuracy of these services will vary as a function of location and data source. Refer to the metadata available in
the services, and follow the links to the original sources for further details. Estimates of CE90 and LE90 are included
as attributes.

Attribution
Sources: USGS, NGA, NASA, CGIAR, NLS, OS, NMA, Geodatastyrelsen, GSA, GSI and the GIS User Community

Coverage
The following coverage map illustrates the coverage of the layer:
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Terrain 3D

The Terrain 3D layer provides global elevation data for work in 3D.

Service Name: Terrain3D

Description
Terrain 3D is a cached tiled elevation image service layer in which the cache is compressed using Limited Error
Raster Compression (LERC). This elevation surface is suitable for use in 3D clients such as Scene Viewer and ArcGIS
Pro scenes for oblique viewing.

For more information, see Use the Terrain 3D service.

Attribution
Sources: USGS, NGA, NASA, CGIAR, NLS, OS, NMA, Geodatastyrelsen, GSA, GSI, and the GIS User Community

Coverage
The following coverage map illustrates the coverage of the layer:
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Elevation analysis
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Profile

The Profile geoprocessing tool returns an elevation profile table for the input line features based on the Terrain
layer.

Service Names: Elevation and ElevationSync

Note:
The Profile geoprocessing tool is not included with Collection 1.

Description
The Elevation and ElevationSync geoprocessing services provide the Profile geoprocessing tool. The Profile tool is
used to create a table of elevation values along input profile lines. The output can be used to create an elevation
profile graph.

This tool can use line features that you interactively draw or those from a line layer.

Background
See Use the elevation analysis services for more information about how this service works; in particular, see the
Profile section.

See Publish the elevation analysis services for details about the configurations needed to enable this service.

Data
Various parts of the world are covered by different resolutions of data.

1,000-meter resolution
This tool currently works worldwide based on the General Bathymetric Chart of the Oceans (GEBCO) data at
30-arcsecond (approximately 1,000-meter) resolution.

500-meter resolution
This tool currently works worldwide based on GEBCO data at 15-arcsecond (approximately 500-meter) resolution.

90-meter resolution
This tool currently works worldwide between 60 degrees north and 56 degrees south based on the 3-arcsecond
(approximately 90-meter) resolution Shuttle Radar Topography Mission (SRTM) dataset.
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30-meter resolution
In North America (Canada, the United States, and Mexico), the tool uses 1-arcsecond (approximately 30-meter)
resolution data from the United States Geological Survey (USGS) National Elevation Dataset (NED). In Australia, the
tool is available based on the 1-arcsecond (approximately 30-meter) resolution SRTM DEM-S dataset from
Geoscience Australia. In the remaining parts of the world (Africa, South America, most of Europe and continental
Asia, the East Indies, New Zealand, and islands of the western Pacific), the tool is available based on the 1-arcsecond
(approximately 30-meter) resolution SRTM data between 60 degrees north and 56 degrees south.

10-meter resolution
In the continental United States, the tool is available based on the 1/3-arcsecond (approximately 10-meter)
resolution USGS NED. In Norway, Finland, Estonia, Denmark, Austria, Spain, Japan, Latvia, Lithuania, the Slovak
Republic, Italy, Switzerland, and Liechtenstein, the tool is available based on approximately 10-meter resolution data
from various authoritative sources.

Attribution
Sources: USGS, NASA, CGIAR, GEBCO, NLS, NMA, Geodatastyrelsen, GSA, GSI, and the GIS User Community
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Viewshed

The Viewshed geoprocessing tool creates viewshed polygons for observation points you specify on a global
elevation dataset.

Service Name: Elevation

Note:
The Viewshed geoprocessing tool is not included with Collection 1.

Description
The Elevation geoprocessing service provides the Viewshed geoprocessing tool. The Viewshed tool calculates visible
areas for a given set of input observation points.

This tool can use point features that you interactively draw or those from a point layer.

Background
See Use the elevation analysis services for more information about how this service works; in particular, see the
Viewshed section.

See Publish the elevation analysis services for details on the configurations needed to enable this service.

Data
Various parts of the world are covered by different resolutions of data.

90-meter resolution
This tool currently works worldwide between 60 degrees north and 56 degrees south based on the 3-arcsecond
(approximately 90-meter) resolution Shuttle Radar Topography Mission (SRTM) dataset.

30-meter resolution
In North America (Canada, the United States, and Mexico), the tool uses 1-arcsecond (approximately 30-meter)
resolution data from the United States Geological Survey (USGS) National Elevation Dataset (NED). In Australia, the
tool is available based on the 1-arcsecond (approximately 30-meter) resolution SRTM DEM-S dataset from
Geoscience Australia. In the remaining parts of the world (Africa, South America, most of Europe and continental
Asia, the East Indies, New Zealand, and islands of the western Pacific), the tool is available based on the 1-arcsecond
(approximately 30-meter) resolution SRTM data between 60 degrees north and 56 degrees south.

10-meter resolution
In the continental United States, the tool is available based on the 1/3-arcsecond (approximately 10-meter)
resolution USGS NED. In Norway, Finland, Estonia, Denmark, Austria, Spain, Japan, Latvia, Lithuania, the Slovak
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Republic, Italy, Switzerland, and Liechtenstein, the tool is available based on approximately 10-meter resolution data
from various authoritative sources.

Attribution
Sources: USGS, NASA, CGIAR, GEBCO, NLS, NMA, Geodatastyrelsen, GSA, GSI, and the GIS User Community
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Summarize Elevation

The Summarize Elevation geoprocessing tool calculates elevation, slope, and aspect statistics for point, line, or
polygon features you specify on a global elevation dataset.

Service Name: Elevation

Note:
The Summarize Elevation geoprocessing tool is not included with Collection 1.

Description
The Elevation geoprocessing service provides the Summarize Elevation geoprocessing tool. The Summarize
Elevation tool is used to calculate elevation, slope, and aspect statistics for a given set of input point, line, or
polygon features.

This tool can use features that you interactively draw or those from a feature layer.

Background
See Use the elevation analysis services for more information about how this service works; in particular, see the
Summarize Elevation section.

See Publish the elevation analysis services for details about the configurations needed to enable this service.

Data
Various parts of the world are covered by different resolutions of data.

90-meter resolution
This tool currently works worldwide between 60 degrees north and 56 degrees south based on the 3-arcsecond
(approximately 90-meter) resolution Shuttle Radar Topography Mission (SRTM) dataset.

30-meter resolution
In North America (Canada, the United States, and Mexico), the tool uses 1-arcsecond (approximately 30-meter)
resolution data from the United States Geological Survey (USGS) National Elevation Dataset (NED). In Australia, the
tool is available based on the 1-arcsecond (approximately 30-meter) resolution SRTM DEM-S dataset from
Geoscience Australia. In the remaining parts of the world (Africa, South America, most of Europe and continental
Asia, the East Indies, New Zealand, and islands of the western Pacific), the tool is available based on the 1-arcsecond
(approximately 30-meter) resolution SRTM data between 60 degrees north and 56 degrees south.
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10-meter resolution
In the continental United States, the tool is available based on the 1/3-arcsecond (approximately 10-meter)
resolution USGS NED. In Norway, Finland, Estonia, Denmark, Austria, Spain, Japan, Latvia, Lithuania, the Slovak
Republic, Italy, Switzerland, and Liechtenstein, the tool is available based on approximately 10-meter resolution data
from various authoritative sources.

Attribution
Sources: USGS, NASA, CGIAR, GEBCO, NLS, NMA, Geodatastyrelsen, GSA, GSI, and the GIS User Community
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Use
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Use services
You can develop apps using the maps and globes available with ArcGIS Data Appliance. If there's an individual map
you want to use in a map or app you've created, visit the following topics to learn where to go for instructions on
adding the service to the map or app:
• Use basemap and reference services

• Use the World Elevation services

• Use the elevation analysis geoprocessing services

ArcGIS Data Appliance 2025 Raster Services Help

Copyright © 1995-2024 Esri. All rights reserved. 104



Use basemap and reference services
Once you've published map services, those map services can be used in a large number of Esri and non-Esri
applications.

For information about the available map services, see Directory of maps and data.

ArcGIS 11.3
For information about clients for ArcGIS 11.3, including Esri client applications and non-Esri client applications, see
Clients for map services in the ArcGIS Server 11.3 help under Manage Services > Types of services > Map
services.

ArcGIS 11.2
For information about clients for ArcGIS 11.2, including Esri client applications and non-Esri client applications, see
Clients for map services in the ArcGIS Server 11.2 help under Manage Services > Types of services > Map
services.

ArcGIS 11.1
For information about clients for ArcGIS 11.1, including Esri client applications and non-Esri client applications, see
Clients for map services in the ArcGIS Server 11.1 help under Manage Services > Types of services > Map
services.

ArcGIS 10.9.1
For information about clients for ArcGIS 10.9.1, including Esri client applications and non-Esri client applications, see
Clients for map services in the ArcGIS Server 10.9.1 help under Manage Services > Types of services > Map
services.
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https://enterprise.arcgis.com/en/server/11.3/publish-services/windows/clients-for-map-services.htm
https://enterprise.arcgis.com/en/server/11.2/publish-services/windows/clients-for-map-services.htm
https://enterprise.arcgis.com/en/server/11.1/publish-services/windows/clients-for-map-services.htm
https://enterprise.arcgis.com/en/server/10.9.1/publish-services/windows/clients-for-map-services.htm


Use the World Elevation services
With ArcGIS Data Appliance 2025, the Terrain and Terrain 3D services are available to use for visualization and
analysis. The following sections explain how to use the services:
• Use the Terrain service

• Use the Terrain3D service

Use the Terrain service
Once you've published the terrain image service, you can use it in ArcGIS 10.9.1 or later, ArcGIS Pro 3.1 or later, and
ArcGIS Online. Terrain is a dynamic image service comprising multiple sources and resolutions ranging from 1,000
meters to 0.25 meters. It can be used for visualization and analysis.

The following sections explain how to do the following:
• Use Terrain in ArcGIS Desktop

• Use Terrain in ArcGIS Online or Portal for ArcGIS

Use Terrain in ArcGIS Desktop
The following sections explain how to do the following:

• Use the Terrain service in ArcGIS Pro

• Use Terrain for analysis in ArcGIS Pro

Use the Terrain service in ArcGIS Pro

To use the Terrain service in ArcGIS Pro, complete the following steps:

1. Start ArcGIS Pro and choose the Map project template.

2. On the Insert tab, click Connections and choose New ArcGIS Server.

3. Provide the URL of the server where you published the Terrain service.

4. On the Map tab, click Add Data, and click Data.

5. Click Servers, double-click the server connection, and select the Terrain service.
The Terrain service is added to the map. By default, the service renders as an elevation (DEM) raster.

6. Right-click Terrain, and click Properties > Processing Templates.

7. From the Processing Template drop-down list, choose one of the functions defined on the service.

8. Click OK.
The map dynamically renders the elevation derivative selected from the drop-down list.

Use Terrain for analysis in ArcGIS Pro

The Terrain service includes data with resolutions ranging from more than 1,000 meters to approximately 0.25
meters in some limited areas, and each record (raster item) is populated with the Dataset_ID and ProductName
values, which can be used for filtering. Since the service is composed of multiple-resolution datasets, it is
recommended that you filter a single resolution (or dataset) before consuming it for analysis. The following steps
are for creating a temporary layer using the Make Image Server Layer geoprocessing tool for a particular area of
interest.
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1. Add the Terrain service to a map in ArcGIS Pro.

2. Zoom to Crafton Hills, CA, USA at scale of 1:18000.

3. Click Identify on the Terrain service.
A list of raster items is returned.

4. Examine the LowPS (cell resolution in meters) values of rasters in the Identify result window.

5. Determine the resolution you need to work with and note the ProductName field value.
This example is for the NED_1r3_arcsec dataset, which has a resolution of approximately 10.3 meters.

6. Open the Make Image Server Layer tool.

7. Define the parameters.
a. For Input Image Service, browse to the server connection for the TerrainImageServer image service.

b. Set Expression to "ProductName" = 'NED_1r3_arcsec'.

c. Optionally, set the output coordinates from the environment setting, if the request being made is different
from the image service coordinates (Web Mercator).

d. Specify the extent. It should be less than 5000 x 5000 pixels. If the pixel size is 10 meters, the max extent
should be 50,000 meters x 50,000 meters.

Note:
The request size of the output layer is limited to 5,000 by 5,000 pixels (property defined on mosaic datasets
and service). The administrator or publisher can increase this limit on the mosaic and service, if required.

e. Specify the Output Cell Size value as 10.3.
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f. Click Run to run the tool.

On successful completion, a temporary layer is generated and added to the Contents pane with cell size, coordinate
system, extent, and expression parameters defined in the tool. This temporary elevation layer can now be used in
other geoprocessing tools (for example, Contours) for further analysis.

For information about using mosaic datasets and image services in geoprocessing tools, see Using mosaic datasets
and image services in geoprocessing tools in the ArcGIS Pro help.

Use Terrain in ArcGIS Online or Portal for ArcGIS
To use the Terrain service in ArcGIS Online or Portal for ArcGIS, complete the following steps:

1. Go to the REST endpoint of the Terrain service, for example, https://localhost:6443/arcgis/rest/
services/Terrain/ImageServer.

2. Click ArcGIS Online Map Viewer.
The Terrain service opens in Map Viewer in a browser. By default, it renders as elevation (DTM).

3. In the right side pane, click the Processing templates button .

ArcGIS Data Appliance 2025 Raster Services Help

Copyright © 1995-2024 Esri. All rights reserved. 108

https://pro.arcgis.com/en/pro-app/latest/help/data/imagery/using-mosaic-datasets-and-image-services-in-gp-tools.htm
https://pro.arcgis.com/en/pro-app/latest/help/data/imagery/using-mosaic-datasets-and-image-services-in-gp-tools.htm


The Processing templates pane appears, listing all the processing templates associated with the Terrain layer.

4. Choose Grayscale_Hillshade and click Done.
The map renders the hillshade.

Optionally, you can select any other available renderer for visualization in Map Viewer.

Use the Terrain3D service
Once you've published the Terrain 3D service, you can use it in ArcGIS 10.9.1 or later, ArcGIS Pro 2.9 or later, and
ArcGIS Online. The following sections explain how to use the Terrain 3D service:
• Use the service in ArcGIS Pro

• Use the service in ArcGIS Online or Portal for ArcGIS

Use the service in ArcGIS Pro
To use the Terrain3D service in ArcGIS Pro, complete the following steps:

1. Start ArcGIS Pro and choose the Global_Scene project template.

2. On the Insert tab, click Connections and choose New ArcGIS Server.

3. Provide the server URL where you published the Terrain3D service.

4. On the Map tab, click Add Data > Elevation Source.

5. Click Servers, double-click the server connection, and select the Terrain3D service.
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The elevation source is added to the ground.

6. Optionally, turn off or remove the default ArcGIS Online elevation layer (WorldElevation3D/Terrain3D) from
Ground.

7. Zoom to any location and tilt the scene to view the oblique views.

With ArcGIS Pro, you can add your unique 2D and 3D data layers to the scene. Your data is added to the elevation
surface. If your data has defined elevation (z-coordinates), this information is honored in the scene. You can then
share your work as a web scene with others in your organization or with the public.

For information about scenes in ArcGIS Pro, see Scenes in the ArcGIS Pro help under Maps and scenes > Author
maps and scenes.

Use the service in ArcGIS Online or Portal for ArcGIS
To use the Terrain3D service in ArcGIS Online or Portal for ArcGIS, complete the following steps:

1. Sign in to ArcGIS Online or your organization's Portal for ArcGIS.

2. Open Scene Viewer.

3. On the Designer toolbar, click Add Layers to add layers, and click ArcGIS web service to open the Enter
Layer URL pane.

4. In the Enter Layer URL pane, in the Layer URL text box, enter the REST endpoint of the Terrain3D service
published on your server, for example, https://localhost:6443/arcgis/rest/services/Terrain3D/
ImageServer.

5. Click Add to add the layer to your scene.
The Terrain3D elevation layer is added as Ground.

Using Scene Viewer in ArcGIS Online, you can create and interact with 3D scenes. Your data is added to the
elevation surface. If your data has defined elevation (z-coordinates), this information is honored in the scene. You
can then share your work as a web scene with others in your organization or with the public.

For information about using the 3D scene viewer, see Get started with Scene Viewer in the ArcGIS Online help.
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Use the elevation analysis geoprocessing services
With the Elevation and ElevationSync geoprocessing services running on your data appliance, you can perform
raster analysis and map and share the results with others in your organization. By having these services running on
a data appliance, you don't need to find authoritative base data. You can create results more quickly than if you had
to acquire and maintain terabytes of data on local machines.

With ArcGIS Data Appliance 2025, the elevation geoprocessing tools Profile, Viewshed, and Summarize Elevation are
available. First, to access the functionality, you must activate the particular service, which is discussed in the next
section. More specific details about the Profile, Viewshed, and Summarize Elevation tools are provided in the
sections that follow.

Elevation geoprocessing services details
Once you've published the elevation analysis geoprocessing services, you can use the services in ArcGIS Enterprise
10.9.1 or later, ArcGIS Pro 3.1 or later, and ArcGIS Online.

For general information about using services, see Using geoprocessing services in the ArcGIS Server help by clicking
Manage Services > Types of services > Geoprocessing services or Use geoprocessing services in ArcGIS Pro in
the ArcGIS Pro help by clicking Help > Analysis and geoprocessing > Geoprocessing > Share geoprocessing >
Share analysis with geoprocessing services > Using.

Elevation data
The elevation data used by the services is collated and curated by Esri and made available as part of the ArcGIS
Data Appliance 2025 installation. A key benefit is that the elevation data has already been preprocessed and
optimized for fast performance. As new areas and better resolutions are made available, they will be included in
future updates.

The elevation data comes from the U.S. Geological Survey (USGS), U.S. National Geospatial-Intelligence Agency
(NGA), U.S. National Aeronautics and Space Administration (NASA), and other authoritative sources. While elevation
data is available for the entire surface of the earth, there are higher resolutions available for particular geographic
extents. The following table lists the available data resolutions, the area covered by each, and the primary sources.
The data is furnished in a spherical coordinate system with units of arc seconds, but it is listed here by its metric
approximations for convenience.

Resolution Area covered Source

10
meters
(1/3 arc
second)

1. The continental United States
2. Norway, Finland, Estonia, Denmark, Austria,

Spain, Japan, Latvia, Lithuania, the Slovak
Republic, Italy, Switzerland, and Liechtenstein

USGS National Elevation Dataset and other
authoritative sources.

30
meters (1
arc
second)

1. The continental United States, Canada, and
Mexico

2. Africa, South America, most of Europe and
continental Asia, the East Indies, New Zealand,
and islands of the western Pacific between 60
degrees north and 56 degrees south

3. Australia

1. USGS National Elevation Dataset.
2. The 1 arc second (approximately 30
meters) resolution Shuttle Radar
Topography Mission (SRTM) dataset.
3. In Australia, the tool is available based on
the 1 arc second (approximately 30 meters)
resolution SRTM DEM-S dataset from
Geoscience Australia.
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Resolution Area covered Source

90
meters (3
arc
seconds)

The land surface of the world between 60 degrees
north and 56 degrees south Shuttle Radar Topography Mission (SRTM).

500
meters
(15 arc
seconds)

The entire surface of the world General Bathymetric Chart of the Oceans
(GEBCO).

1,000
meters
(30 arc
seconds)

The entire surface of the world General Bathymetric Chart of the Oceans
(GEBCO).

Bathymetry data for the oceans is also included in the global elevation service, allowing you to derive profiles down
to the seafloor over ocean areas.

Control the resolution

Which source data is used depends on the setting of the DEM Resolution parameter as well as the particular
location of the line feature for which you are trying to create a profile.

Profile
The Profile tool allows you to create profiles of your choosing anywhere on the surface of the earth.

View the following sections for more information on the Profile tool:
• Elevation profile

• Asynchronous and synchronous Profile tool differences

• Use the Profile tool in ArcGIS Pro

• Tool parameters

• Usage notes

Elevation profile
An elevation profile shows you the height (or depth) of a surface along the length of a linear feature. It is an
effective way to visualize and understand the elevation and topography of the surface of the earth.

Asynchronous and synchronous Profile tool differences
There are two Profile tools available, one in the Elevation toolbox and the other in the ElevationSync toolbox. They
do essentially the same thing but with different intended uses. The first one is an asynchronous task, designed for
long-running tasks, such as batch processing a large number of profile lines at once from a single input feature
class. The synchronous task (the one in the ElevationSync toolbox) is designed for interactive profile applications,
which typically have fewer input lines and require a faster response. For example, if you are creating a profile web
app that generates profile graphs on the fly, use the synchronous tool.

There should be no noticeable difference between the asynchronous and synchronous Profile tools, with the
exception that the asynchronous Profile tool allows a maximum of 1,000 input line features at a time, whereas the
synchronous Profile tool allows a maximum of 100.
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Use the Profile tool in ArcGIS Pro
To create a profile in ArcGIS Pro, first connect to the ArcGIS Server site of your data appliance that is hosting the
elevation geoprocessing services. Once that is done, you are ready to start creating profiles.

1. In the ArcGIS Pro Catalog pane, add a server connection to the ArcGIS Server site where the elevation services
are published.

2. In the ArcGIS Pro Catalog pane, expand the server connection, and expand the Elevation and ElevationSync
server toolboxes.

Note that there are two Profile tools available. The first is for asynchronous applications and the second is for
synchronous ones.

3. Click a Profile tool to open the tool dialog box.

4. Specify the line for which you want to create the profile.
There are two ways you can do this, depending on how the Input Line Features parameter is set:
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• Click the edit button to draw your profile line directly on the map. Click to add a vertex and double-click to
finish.

• Click the browse button to browse to and select an existing line feature for which you want to create a
profile.

5. Set the other parameters as you prefer, and specify a value for the maximum sample distance parameter.

6. Click Run to run the tool.
The result is added to the table of contents of the current map as a feature layer.

The output is a polyline feature layer with elevation values extracted along the line you specified. The elevation
values and distance values are stored as z- and m-values in the output features. Three attribute fields of the output
features record the Terrain source data used in the calculation. The Product Name field identifies the elevation data
product used in the analysis. The Source and Source URL fields give further details about the provider of the data.
The following is an example of the attribute table of a profile output:

To create the profile chart in ArcGIS Pro, right-click the Output Profile layer in the table of contents and point to
Create Chart on the context menu, and click Profile Graph on the menu to finish. The following is an example of
the resulting profile chart:

Tool parameters
The following are the parameters for the Profile tool:

Parameter Description

Input Line
Features The line feature for the information necessary to create a profile.

Profile ID
Field A string or integer unique identifier to tie profiles to their corresponding input line features.
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Parameter Description

DEM
Resolution

The approximate spatial resolution (cell size) of the source elevation data used for the calculation.
The default is 90m.
The available values are FINEST | 10m | 30m | 90m | 500m | 1000m.

The resolution keyword is an approximation of the spatial resolution of the digital elevation model.
While many elevation sources are distributed in units of arc seconds, the keyword is an
approximation of those resolutions in meters for easier understanding. The Finest option indicates
that the highest-resolution DEM possible is to be used.

Maximum
Sample
Distance

The maximum sampling distance along the line to sample elevation values.

Maximum
Sample
Distance
Units

The units for the MaximumSampleDistance.
The available values are Meters | Kilometers | Feet | Yards | Miles.

Usage notes
The following notes provide information to help you use the Profile tool:
• The output line features are in the same coordinate system as the input line features. The z- and m-values of the

vertices are in meters.

• The Length Meters output field holds the planimetric length of the profile line calculated as a geodesic distance
and is the correct length regardless of the coordinate system of the data. This length will be different from the
shape_length attribute due to the effects of map projection distortion.

• When the Maximum Sample Distance parameter is empty or not supplied, a default sampling distance is
calculated based on how many vertices are available on the input line feature. If the input line feature contains
fewer than 50 vertices, the default sampling distance is the length of the input line feature divided by 49. If the
input has 50 or more, but fewer than 200 vertices, the default sampling distance is the length of the input line
feature divided by 199. If the number of vertices is from 200 to the maximum of 1,024, the input line feature will
not be densified if the Maximum Sample Distance parameter is empty or not specified.

• The maximum number of input lines is 1,000 for the asynchronous profile task. For the synchronous profile task,
the maximum number of input lines is 100. If additional input lines are provided, the service will return an error
and will not run.

• The maximum number of elevation values returned from the task is 2,000 for each input line. The task will return
an error message and will not run if a request results in more than this maximum number of elevation values. If
this occurs, either specify a larger sampling distance or input a line feature with fewer vertices, or both.

• The task will return an error message if the specified DEM resolution is not available at any of the input feature
locations.

Viewshed
The Viewshed tool returns polygons of visible areas for a given set of input observation points.

View the following sections for more information on the Viewshed tool:
• Viewshed analysis

• Use the Viewshed tool in ArcGIS Pro
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• Tool parameters

• Usage notes

Viewshed analysis
The purpose of viewshed analysis is to identify visible areas. You specify the observer locations you are interested in,
either from a dataset or interactively, and the Viewshed tool combines this with terrain data to create output
polygons of visible areas, the areas that can be seen from the observer locations.

Use the Viewshed tool in ArcGIS Pro
To create a viewshed, first connect to the ArcGIS Server site of your data appliance that is hosting the elevation
geoprocessing services. Once the server connection is ready, complete the following steps to run the Viewshed tool:

1. In the ArcGIS Pro Catalog pane, after connecting to the server, expand the Elevation toolbox.

2. Click the Viewshed tool to open the tool dialog box.
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3. Specify the input points for which you want to create the viewshed.
There are two ways you can do this, depending on how the Input Line Features parameter is set:

• Click the edit button to draw your input points directly on the map.

• Click the browse button to browse to and select an existing point feature class or shapefile for which you
want to create a viewshed.

4. Specify a value for Maximum Distance or leave it as the default.
The largest value allowed in this parameter is 15 kilometers for the 10m and 30m DEM resolutions, and 50
kilometers for the 90m DEM resolution. If this parameter is not set, the default is 5 kilometers for the 10m DEM
resolution, and 15 kilometers for the rest of the DEM resolutions.

5. Select a value for DEM Resolution to be used by the viewshed calculation, or leave it as the default.
By default, the 90m resolution is used.

6. Specify a value for Observer Height or accept the default value, which represents the height of observers above
the surface.
Similarly, you can specify a value for Surface Offset that represents the height of targets above the surface.

By default, the output viewshed polygons are simplified.

7. To get unsimplified output viewshed polygons, uncheck the Generalize Viewshed Polygons check box.
Simplified viewshed polygons have smoother edges and a smaller output data size, allowing the result to be
returned from the server significantly faster with a small loss of accuracy.

8. Click Run to run the tool.
The output viewshed is added to the table of contents of the current map as a polygon feature layer.
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The output polygon features represent areas that are visible to the input point features. The following is an example
of the output viewshed created using the 10m DEM resolution, with a maximum distance of 15 km, for one observer
point:

For each polygon in the output feature class, the attribute table has a Frequency field recording the number of
observers that can see it. Three additional attribute fields record the Terrain source data used in the calculation. The
Product Name field identifies the elevation data product used in the analysis. The Source and Source URL fields
give further details about the provider of the data. The following is an example of the output viewshed attribute
table:

Tool parameters
The following are the parameters for the Viewshed tool:

Parameter Description

Input
Points The point features to use as the observer locations.

Maximum
Distance

The maximum viewing distance of the observers. The output viewshed will be calculated within this
distance.

Maximum
Distance
Units

Specifies the units for the Maximum Distance parameter.
The available values are Meters | Kilometers | Feet | Yards | Miles.

DEM
Resolution

The approximate spatial resolution (cell size) of the source elevation data used for the calculation.
The default is 90m.
The available values are FINEST | 10m | 30m | 90m.

The resolution keyword is an approximation of the spatial resolution of the digital elevation model.
While many elevation sources are distributed in units of arc seconds, the keyword is an
approximation of those resolutions in meters for easier understanding. The Finest option indicates
that the highest-resolution DEM possible is to be used.
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Parameter Description

Observer
Height

The height above the surface of the observers.
The default value of 1.75 meters represents the height of an average person. If the observers are
looking from an elevated location such as an observation tower or a building, use that height
instead.

Observer
Height
Units

Specifies the units for the Observer Height parameter. The default is meters.
The available values are Meters | Kilometers | Feet | Yards | Miles.

Surface
Offset

The height above the surface of the objects you are viewing. The default value is 0. If you are
viewing buildings or wind turbines, use their height.

Surface
Offset
Units

Specifies the units for the Surface Offset parameter. The default is meters.
The available values are Meters | Kilometers | Feet | Yards | Miles.

Generalize
Viewshed
Polygons

Specifies whether the viewshed polygons will be generalized.
The viewshed calculation is based on a raster elevation model that creates a result with stair-
stepped edges. To create a more pleasing appearance and improve performance, the default
behavior generalizes the polygons. This generalization will not change the accuracy of the result
for any location more than one-half of the cell size corresponding to each DEM resolution.

Usage notes
The following notes provide information to help you use the Viewshed tool:
• There are several elevation sources available that have different spatial resolutions and cover different areas. Not

all resolutions are available for all areas. See the Elevation data section for more details. The tool returns an error
message if the specified resolution is not available at any of the specified input observer locations.

• The tool uses a single resolution elevation source for the input features. If all input features don't fit into a single
resolution, the tool identifies the highest resolution that covers the input features.

• If the DEM Resolution parameter is not set, the coarsest resolution (90m) is used. If Finest is specified, the tool
uses the highest resolution available at the observer location that is allowed by the Maximum Distance
parameter.

• For the Maximum Distance parameter, the largest value allowed for the 10m and 30m DEM resolutions is 15
kilometers. For the 90m DEM resolution, the largest value allowed is 50 kilometers. If this parameter is not set, the
tool will use a default value based on the DEM Resolution parameter. For 10m resolution, the default maximum
distance is 5 kilometers. For both the 30m and the 90m DEM resolutions, the default maximum distance is 15
kilometers.

• For water bodies, the tool uses the local water surface as the elevation surface. Oceans are assigned a value of
zero and water bodies are assigned an appropriate flat local elevation.

• The output viewshed is returned as polygon features. The Frequency field is used to record the number of
observation points from which each polygon is visible. The DEMResolution field is used to record the source
DEM resolution for the viewshed computation.

• Three additional fields are returned that identify the Terrain source data used in the calculation. The Product

Name field identifies the data product used in the analysis. The Source and Source URL fields give further details
about the provider of the data.
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• A lower DEM resolution results in a faster tool response. For example, the 90m resolution has the shortest
response time. The tradeoff is that a lower DEM resolution has a lower accuracy in the viewshed result compared
to that of a higher DEM resolution.

• The Maximum Distance parameter may also affect the tool response time. In general, using a smaller distance
results in a shorter response time.

• The maximum number of input points is 1,000. If more than 1,000 input points are provided, the tool returns an
error and will not run.

Summarize Elevation
The Summarize Elevation tool calculates summary statistics for features you provide based on the elevation in
Terrain data. It accepts point, line, or polygon input and returns statistics for the elevation, slope, and aspect of the
features.

View the following sections for more information on the Summarize Elevation tool:
• Use the Summarize Elevation tool in ArcGIS Pro

• Tool parameters

• Usage notes

Use the Summarize Elevation tool in ArcGIS Pro
To calculate summary statistics for input features, first connect to the ArcGIS Server site of your data appliance that
is hosting the elevation geoprocessing services. Once the server connection is ready, complete the following steps
to run the Summarize Elevation tool:

1. In the ArcGIS Pro Catalog pane, after connecting to the server, expand the Elevation toolbox.

2. Click the SummarizeElevation tool to open the tool dialog box.
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3. Specify the input features for which you want to calculate elevation statistics. The input features can be points,
lines, or polygons.
There are two ways you can do this, depending on how the Input Features parameter is set:

• Click the Edit tool to draw your input features directly on the map.

• Click the browse button to browse to and select an existing feature class or shapefile for which you want
to run the tool.

4. Optionally, set the Feature ID Field parameter. Specify an object ID field or an integer field, or leave it blank.
If no value is specified, the object ID field is used by default.

5. Select a DEM Resolution value that the statistic calculation will be based on.
If no value is specified, the 90m DEM resolution is used by default.

By default, only the elevation statistics are calculated.

6. To include slope and aspect statistic calculations, check the Include Slope and Aspect parameter.

7. Click Run to run the tool.

Once the tool finishes running, the result is returned as a feature class with the elevation, slope and aspect statistics
attached as attribute fields in the feature attribute table. The elevation statistics are found in the Minimum
Elevation, Mean Elevation, and Maximum Elevation fields. The slope statistics are found in the Minimum Slope,
Mean Slope, and Maximum Slope fields. The aspect statistics are found in the Mean Aspect field.

The following is an example of the output feature attribute table:

Tool parameters
The following are the parameters for the tool:

Parameter Description

Input
Features The input point, line, or area features for which the elevation will be summarized.

Feature ID
Field The unique ID field to use for the input features.
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Parameter Description

DEM
Resolution

The approximate spatial resolution (cell size) of the source elevation data used for the calculation.
The default is 90m.
The available values are FINEST | 10m | 30m | 90m.

The resolution keyword is an approximation of the spatial resolution of the digital elevation model.
While many elevation sources are distributed in units of arc seconds, the keyword is an
approximation of those resolutions in meters for easier understanding. The Finest option indicates
that the highest-resolution DEM possible is to be used.

Include
Slope and
Aspect

Specifies whether slope and aspect values for the input features will be included in the output in
addition to the elevation values.

• Checked—Slope and aspect values will be included in the output.
• Unchecked—Slope and aspect values will not be included in the output. This is the default.

Usage notes
The following notes provide information to help you use the Summarize Elevation tool:
• This tool summarizes the elevation, slope, and aspect information for the input features. The returned elevation

values are in meters. The slope and aspect values are calculated and returned in degrees.

• There are several elevation sources available that have different spatial resolution and cover different areas. Not
all resolutions are available for all areas. The tool will return an error message if the specified resolution is not
available at any of the input feature locations.

• The maximum number of input features is 1,000. If more than 1,000 input features are provided, the tool will
return an error and will not run.

• If the DEM Resolution parameter is not supplied, the 90-meter resolution SRTM data will be used. If Finest is
specified, the tool will use the smallest resolution available at the input feature locations.

• The tool uses a single resolution elevation source for the input features. The highest resolution elevation source
that covers the extent of all the input features will be used.

• The results are appended to the returned feature attribute table as fields. The MinElevation, MeanElevation, and
MaxElevation fields summarize elevation. The MinSlope, MeanSlope, and MaxSlope fields summarize slope.
The MeanAspect field summarizes aspect.

• The returned features are in the same shape type as the input features. For example, if the input features are
points, the returned features are also points.

• Oceans and other major water bodies are ignored in the calculations and do not affect the summary values.
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Common attributes for maps using the Web Mercator
Auxiliary Sphere tiling scheme
All ArcGIS Data Appliance maps use the Web Mercator Auxiliary Sphere tiling scheme (WKID 102100), which is the
same tiling scheme that ArcGIS Online, Google Maps, and Bing Maps use.

All ArcGIS Data Appliance maps use the same coordinate system, map DPI, and tile size. Cached levels of detail for
each map and layer match; however, not all maps and layers contain all levels of detail.

Coordinate system: WGS 1984 Web Mercator (Auxiliary Sphere)

Units of measure: esriMeters

Global extent:
• XMin: -20037507.0671618

• YMin: -19971868.8804086

• XMax: 20037507.0671618

• YMax: 19971868.8804086

Spatial reference: 102100 (3857)

Map DPI: 96

Tile size of map cache: 256 pixels by 256 pixels

Levels of detail: The number of cached levels of detail varies among maps. The scale levels are calculated based on
the tile size (256 by 256) and the WGS 1984 Web Mercator Auxiliary Sphere coordinate system so that when tiles
are laid out starting at 180W and proceeding eastward, the final tile aligns perfectly (no overlap) with the first tile at
the international date line.

The standard map scale and cell size for each layer are shown in the following table:

Layer level Map scale Cell size

L00 1:591,657,528
1 pixel = 1.40624 decimal degrees
(Meters at equator: 156,543.033928)

L01 1:295,828,764
1 pixel = 0.70312 decimal degrees
(Meters at equator: 78,271.516964)

L02 1:147,914,382
1 pixel = 0.35156 decimal degrees
(Meters at equator: 39,135.758482)

L03 1:73,957,191
1 pixel = 0.17578 decimal degrees
(Meters at equator: 19,567.879241)

L04 1:36,978,595
1 pixel = 0.08789 decimal degrees
(Meters at equator: 9,783.939620)

L05 1:18,489,298
1 pixel = 0.04395 decimal degrees
(Meters at equator: 4,891.969810)

L06 1:9,244,649
1 pixel = 0.02197 decimal degrees
(Meters at equator: 2,445.984905)
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Layer level Map scale Cell size

L07 1:4,622,324
1 pixel = 0.01099 decimal degrees
(Meters at equator: 1,222.992453)

L08 1:2,311,162
1 pixel = 0.00549 decimal degrees
(Meters at equator: 611.496226)

L09 1:1,155,581
1 pixel = 0.00275 decimal degrees
(Meters at equator: 305.748113)

L10 1:577,791
1 pixel = 0.00137 decimal degrees
(Meters at equator: 152.874057)

L11 1:288,895
1 pixel = 0.00069 decimal degrees
(Meters at equator: 76.437028)

L12 1:144,448
1 pixel = 0.00034 decimal degrees
(Meters at equator: 38.218514)

L13 1:72,224
1 pixel = 0.00017 decimal degrees
(Meters at equator: 19.109257)

L14 1:36,112
1 pixel = 0.00009 decimal degrees
(Meters at equator: 9.554629)

L15 1:18,056
1 pixel = 0.00004 decimal degrees
(Meters at equator: 4.777314)

L16 1:9,028
1 pixel = 0.00002 decimal degrees
(Meters at equator: 2.388657)

L17 1:4,514
1 pixel = 0.00001 decimal degrees
(Meters at equator: 1.194329)

L18 1:2,257
1 pixel = 0.000005 decimal degrees
(Meters at equator: 0.597164)

L19 1:1,128
1 pixel = 0.000003 decimal degrees
(Meters at equator: 0.298582)

L20 1:564
1 pixel = 0.0000015 decimal degrees
(Meters at equator: 0.149291)

L21 1:282
1 pixel = 0.00000075 decimal degrees
(Meters at equator: 0.074646)

L22 1:141
1 pixel = 0.000000375 decimal degrees
(Meters at equator: 0.037322)

L23 1:71
1 pixel = 0.0000001875 decimal degrees
(Meters at equator: 0.018661)
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Publication details and redistribution rights
Publication details and distribution rights for ArcGIS Data Appliance 2025 are as follows:
• Version: 2025.

• Publisher and place: Esri, Redlands, California, USA.

• Publication date: September 2024.

• Access constraints: Access granted to licensee only.

• Use constraints: The data is provided under license to Esri by multiple third-party data vendors for inclusion on
ArcGIS Data Appliance for use with Esri software. Redistribution rights are granted by Esri and the data vendor for
hard-copy renditions or static, electronic map images that are plotted, printed, or publicly displayed with proper
metadata and source or copyright attribution to the respective data vendor or vendors.

See Directory of maps and data for attribution information for a specific service.
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Data attributions and terms of use
View the Data Attributions and Terms of Use page.
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Copyright Information
Copyright © 1995-2024 Esri. All rights reserved. Published in the United States of America.

The information contained in this document is subject to change without notice.

You may have received Products or Services that include Graph Editor Toolkit, Copyright © 1992-1999 Tom Sawyer
Software, Berkeley, California, All Rights Reserved, and Tom Sawyer Visualization, Ver. 8.0 Copyright © 1992-2009
Tom Sawyer Software, Berkeley, California, All Rights Reserved.

Portions of this computer program are Copyright © 1995-2016 Celartem, Inc., dba Extensis. All rights reserved.

This application supports the ECW data format and ECWP compression protocols. Portions of this computer
program are copyright © 2007-2015 Intergraph Corporation. All rights reserved. Creating compressed files using
ECW technology is protected by one or more of U.S. Patent No. 6,201,897, No. 6,442,298, and No. 6,633,688.

PANTONE® Colors displayed in the software application or in the user documentation may not match PANTONE-
identified standards. Consult current PANTONE Color Publications for accurate color. PANTONE® and other
Pantone trademarks are the property of Pantone LLC. © Pantone LLC, 2022. Pantone is the copyright owner of color
data and/or software which are licensed to Esri to distribute for use only in combination with the ArcGIS family of
Products. PANTONE Color Data and/or Software shall not be copied onto another disk or into memory unless as
part of the execution of the ArcGIS family of Products.

This product includes software developed by the JDOM Project.

Note:
The jdom.org site has gone offline as of July 22, 2024. An alternative site may be https://github.com/hunterhacker/
jdom#introduction-to-the-jdom-project.

This product includes software developed by the Indiana University Extreme! Lab
(https://www.extreme.indiana.edu).

Note:
As of August 2024, the webite now states: "This site has been deprecated. You can access an archive of this site at
https://web.archive.org/web/20210225153105/https://www.extreme.indiana.edu/".

ArcGIS consists of many programs and services—some of which may have been developed using Altova®
XMLSpy® and includes libraries owned by Altova GmbH, Copyright © 2007-2023 Altova GmbH (www.altova.com).

Portions of this software may use (XML) schemas, Copyright © 2011 DCMI, the Dublin Core™ Metadata Initiative
(https://dublincore.org). These are licensed under the Creative Commons 4.0 Attribution license
https://creativecommons.org/licenses/by/4.0.

Third-Party OSS-FOSS Acknowledgement Documents
Esri's use of open source software libraries is disclosed in the Third-Party OSS-FOSS Acknowledgement Documents
found at the link below.

Open Source Acknowledgements (https://links.esri.com/open-source-acknowledgments)

ArcGIS Notebooks makes use of The FreeType Project, following The FreeType Project License
(https://git.savannah.gnu.org/cgit/freetype/freetype2.git/tree/docs/FTL.TXT).
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EXPORT NOTICE
Use of these Materials is subject to U.S. export control laws and regulations, including the U.S. Department of
Commerce Export Administration Regulations (EAR). Diversion of these Materials contrary to U.S. law is prohibited.

US GOVERNMENT CUSTOMER
The Products are commercial items, developed at private expense, provided to Customer under this Master
Agreement. If Customer is a US government entity or US government contractor, Esri licenses or provides
subscriptions to Customer in accordance with this Master Agreement under FAR Subparts 12.211/12.212 or DFARS
Subpart 227.7202. Esri Data and Online Services are licensed or subscribed under the same DFARS Subpart
227.7202 policy as commercial computer software for acquisitions made under DFARS. Products are subject to
restrictions, and this Master Agreement strictly governs Customer's use, modification, performance, reproduction,
release, display, or disclosure of Products. Agreement provisions that are inconsistent with federal law regulation
will not apply. A US government Customer may transfer Software to any of its facilities to which it transfers the
computer(s) on which it has installed such Software. If any court, arbitrator, or board holds that a US government
Customer has greater rights to any portion of the Products under applicable public procurement law, such rights
will extend only to the portions affected. Online Services are FedRAMP Tailored-Low authorized but do not meet
higher security requirements, including those found in DFARS 252.239-7010.

Esri Trademarks
Esri Products or Services referenced in this work are trademarks, service marks, or registered marks of Esri in the
United States, the European Community, or certain other jurisdictions. To learn more about Esri marks, go to the Esri
Product Naming Guide (https://links.esri.com/product-naming-guide).

Licensed Trademarks
Other companies and products or services mentioned herein may be trademarks, service marks, or registered marks
of their respective mark owners.

The Kubernetes ship's wheel logo is a registered trademark of the Linux Foundation.

Trademark Images

Logos of licensed trademarks include the following:
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Support for ArcGIS Data Appliance 2025
Support for ArcGIS Data Appliance 2025 is provided by both Esri and Arxys support teams. For the latest
information about ArcGIS Data Appliance, see the ArcGIS Data Appliance website.

Esri support
For questions regarding the configuration and setup of ArcGIS services and usage, contact Esri using the following
options:
• United States users—Contact Esri Support using one of the following options. Hours are Monday through Friday,

5:00 a.m. to 5:00 p.m. (Pacific time), excluding Esri holidays:
▪ Phone—888-377-4575

▪ Web page—https://support.esri.com/en-us/contact

• International users—Support is provided by your local Esri distributor.

Arxys support
For questions and support regarding ArcGIS Data Appliance hardware, contact Arxys using the following options:

• Phone—619-258-7800

• Email—support@arxys.com

• Web page—https://www.arxys.com/company/support/

• Hours—Monday through Friday, 8:00 a.m. to 5:00 p.m. (Pacific time)
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